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Items listed on this document are the Service Pack Enhancements released with incremental 
updates between version steps (e.g. V12.4 To V12.5).

Enhancements are presented from newest to oldest within each section. 

The current version in distribution is 12.4.0.25.  Enhancements with a Service Pack number 
GREATER than this are in BETA, and will be available soon. Look for BV in the left margin to see 
what's coming. You can also search for the entries with “BV” by using the keyboard shortcut CTRL-F, 
entering BV, then selecting the Previous/Next buttons to move between them.

The current version in distribution is 12.4.0.25.  Enhancements with a Service Pack number 
GREATER than this are in BETA, and will be available soon. 

The "KNOW BEFORE YOU GO" section includes important items for your office to review PRIOR 
TO UPDATING to this new version.  Look for screen, table and other changes that might affect your
workflow.   X  Items with a red X are additional important items.

Items marked (Request) were requested by clients and satisfied in the associated update.

Click here to open an E-mail to send questions or comments to the Compulink Documentation department.

The topics in the Table of Contents contain links; click a topic to jump to that spot in the document. 
Click on the red page number at the bottom right of the page to return. 
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KNOW BEFORE YOU GO
 X (12.4.0.24) Exam >Look-up Tables > Medication > Pharmacy > NCPDP ID 

Mandatory

• NCPDP ID is the unique, national identification number assigned by the National Council 
   for Prescription Drug Programs (NCPDP) to every licensed Pharmacy in the United States 
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KNOW BEFORE YOU GO
   and its territories.
• All Pharmacies being used for electronic prescribing, must have an 'NCPDP ID'.
• Surescripts will NOT accept any Pharmacies that do not contain this information.
• When selected from the 'Pharmacy Search' window, the information will default.
• If adding a Pharmacy to the table manually, you must make sure to enter the 'NCPDP ID' 
   if this Pharmacy is going to be used for electronic prescribing.

• If the Pharmacy is unable to provide their NCPDP ID, contact the NCPDP for 
 assistance. https://www.ncpdp.org/Contact-Us.aspx

 X (12.4.0.24) Hot Topic >Exam > Command (E-Rx) > Mandatory Version Update

• Compulink has released a mandatory version update for AdvantageERx users.
• The user interface will see very few changes, however, an industry wide format change 
   will require all of our clients who are currently using AdvantageERx to update to version 
   12.4.0.24 no later than August 31st 2021.
• This release was available as of August 12th 2021.
• Failure to update prior to the deadline will result in AdvantageERx not functioning after 
   August 31st 2021.
• An E-Mail blast with additional information was sent to all clients currently flagged as
  using AdvantageERx.

 X (12.4.0.24) Hot Topic >Exam > Command (E-Rx) > NEW Mandatory Information

• Upon update to version 12.4.0.24 and greater, the electronic prescription software will be 
   updated for new certification requirements through Surescripts.
• Due to these new requirements, as soon as you update, electronic prescriptions for 
   patients 17 years and under, require height and weight to be entered on the 'Vitals' panel
   for successful submission.
• This information will display in the Medication Review screen only for these patients.
• NOTE: Although the new certification starts September 1st, if you update prior to that, 
the 
   software is updated, and will be looking for this newly required information; update 
   today, mandatory today.

 X (12.4.0.20) Exam >Tab(s) > EDITED: All Tabs With Diagnosis/Plan or Dx/Plan

• The 'Forward' functionality was updated. 
          • When forwarding a Diagnosis from a previous Exam, if the 'Severity' and 'Change' 
             fields already contain a value, those values will forward, and the prompt to select 
             a value will not pop up. (Request) 
          • The user still has the option of editing the Diagnosis and making changes.

 X (12.4.0.19) Exam >Command (E-Rx) > Command (Refill) > Response Renamed

• The Refill Response 'Denied New to Follow' was changed to 'Replace' for new certification 
   requirements and better usability. 
• With this change, the software will no longer add a new Medication record for “New to 
   Follow”.
• The original Rx will be assigned a 'Stop' date of the current date, and an 'E-Rx Status' of 
   'Refill Request Replaced'; this change is also for new certification requirements.

 X (12.4.0.19) Patient >Command (Search) > Command (Advanced) > Message For 
Restrictions

• If the staff logged in has a Provider, Staff Group or Location Group assigned in the Login 
   IDs table, the following message will display when clicking the 'Advanced' command: 
   Advanced SQL Search Unavailable for Users that have Restrictions on which Patients can 
   be Accessed due to Assigned Provider or Staff/Groups! Solution scheduled for availability 
   in version 12.5 next Quarter!
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KNOW BEFORE YOU GO
 X (12.4.0.18) Exam >2021 E&M Coding > Data Count Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Discussion Notes
          • Determination
                    • Coding Logic is looking for a Communication record with the following:
                              • Added date equal to the Exam date 
                              • The NEW 'Provider Discussion' field CHECKED 
                              • EMPTY Reviewed date 
• NotesReviewed
          • Determination
                    • Coding Logic is looking for a Communication record with the following:
                              • Added date equal to the Exam date 
                              • The NEW 'Provider Discussion' field UNCHECKED
                              • Reviewed date equal to the Exam date

 X (12.4.0.18) Exam >2021 E&M Coding > Hospitalization Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• In Versions 12.4.0.16, 12.4.0.17 and SOME of 12.4.0.18, Hospitalization was determined 
   by the 'Place of Service' field being equal to one of the following:
          • Inpatient Hospital 
          • Outpatient Hospital 
          • Emergency Room-Hospital
• Starting 3/3/21 in Version 12.4.0.18, Hospitalization will be determined by the following:
          • EHR Order added with a Name starting with 'REFERRAL TO ED/HOSPITAL'.
          • It may be practice specific like 'REFERRAL TO ED/HOSPITAL FOR FRACTURE', but 
             MUST start with 'REFERRAL TO ED/HOSPITAL'.

 X (12.4.0.18) Exam >2021 E&M Coding > Management Level Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Starting 3/3/21 in Version 12.4.0.18: Additional Information:
          • Place of Service determination (Hospital options) HAS CHANGED TO:
          • EHR Order added with a Name starting with 'REFERRAL TO ED/HOSPITAL'.

• Starting 3/3/21 in Version 12.4.0.18: Management Level Determination:
          • Level 4/High
                    • (Medication prescribed AND High Risk memo field documented) or (EHR 
                       Order entered with criteria equal to Component: Non-Drug Rx Prescribed 
                       AND High Risk memo field documented)
                    • EHR Order added with a Name starting with 'REFERRAL TO ED/HOSPITAL'.
                       OR 
                    • Emergency (Diagnosis Severity=Urgent/Emergent)
                       OR
                    • Major Surgery AND High Risk memo field documented

 X (12.4.0.18) Exam >2021 E&M Coding > Place of Service Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• In Versions 12.4.0.16, 12.4.0.17 and SOME of 12.4.0.18, Hospitalization was determined 
   by the 'Place of Service' field being equal to one of the following:
          • Inpatient Hospital 
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KNOW BEFORE YOU GO
          • Outpatient Hospital 
          • Emergency Room-Hospital
• Starting 3/3/21 in Version 12.4.0.18, Hospitalization will be determined by the following:
          • EHR Order added with a Name starting with 'REFERRAL TO ED/HOSPITAL'.
          • It may be practice specific like 'REFERRAL TO ED/HOSPITAL FOR FRACTURE', but 
             MUST start with 'REFERRAL TO ED/HOSPITAL'.

 X (12.4.0.18) Exam >Command (Fees) > EHR Auto Fee Posting Window > Internal 
Counts & Logical Values

• The box in the bottom left corner is now organized into three sections: Problem 
   Level, Data Level and Management Level.
• Below each section, you will find the items that the coding engine looks at to determine 
   that Level; making it easy for you to get an overview of how the E&M visit code was 
   selected.
• Internal Counts and Logical Values below will vary based upon product:
          • Problem Level
          • Data Level – The items that are looked at to determine this Level, were all moved 
             under this section and indented.
                    • External Tests Reviewed
                    • External Tests Ordered
                    • External Tests Interpreted
                    • Historian Comments
                    • Discussion Notes
                    • Notes Reviewed
          • Management Level – The items that are looked at to determine this Level, were all 
             moved under this section and indented.
                    • Rx
                    • Over the Counter
                    • Self Care
                    • Surgery/Treatment – Changed from 'Surgery'
                    • Risk Factors
                    • Emergency
                    • Unknown Problem
                    • Hospitalization Needed – Changed from 'Hospital'

 X (12.4.0.18) Exam >Command (Utility) > Legacy Field Forward Groups > NEW 
Table

• This NEW table was created for the Main Exam database, to define multiple Legacy fields 
   that will forward into a single New field when forwarding from a previous date of service.
• The software will only go back 5 years to forward information from one Exam to the next.
• It will only forward Legacy fields that do NOT exist on the same tab as the New field that 
   they are being forwarded to.
• It will forward all field values, even those that are Normal values.
• This table is not sorted. Enter items in the order you would like them displayed in the 
   table. 
• Add – Add a new record to the bottom of the table.
• Complete the fields within the editing window.
          • Owner – 'C' for Compulink-Owned and 'U' for User-Owned.
          • Hide – 'Y' to hide this item from display in drop-down lists.
          • Group Name – Assign a Name to the Group; this could be similar to the label for 
             the single field that the data is going to be forwarded into.
          • Target Field – The name of the single field in the Main Exam that the data will 
             forward into.
          • Source Field List – This list of field names in the Main Exam (separated by a 
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KNOW BEFORE YOU GO
             comma) that will forward into the 'Target Field'.
          • Modified – The last date a change was made to this entry.
• Click the check to Save the record.
• Example: 
          • Group Name = ROS
          • Target Field = ReviewOfSystems (This is a new memo field)
          • Source Field List (Legacy fields that will forward into the 'ROS' memo field):
                    • ZZCONSTN = Constitution
                    • ZZCARDION = Cardiovascular
                    • ZZEARSN = ENT
                    • ZZRESPN = Respiratory
                    • ZZGASTRON = Gastrointestinal
                    • ZZGENITON = Genitourinary
                    • ZZMUSCN = Musculoskeletal
                    • ZZINTEGN = Integumentary
                    • ZZNEURON = Neurological
                    • ZZPSYCHN = Psychiatric
                    • ZZENDON = Endocrine
                    • ZZHEMATIN = Hematologic/Lymphatic
                    • ZZALLERGN = Allergic/Immunologic
                    • ZZROSOTHN = Other
                    • ZZEYES = Eyes
• After making changes to the table and exiting, the following message will appear: If 
   Changes Were Made then Please Restart Application for Proper Operation!
          • You must completely close out of the Advantage software and log back in; using 
             the 'Log Off' will not finish the process.

 X (12.4.0.18) Exam >Tab(s) > EDITED: All Tabs With Blue Labels

• All tabs containing blue labels next to fields were edited.
• The blue labels were changed to black text, as the new E&M Coding is no longer looking 
   at these fields for coding E&M codes (in office)

 X (12.4.0.18) Exam >Tab(s) > EDITED: All Tabs With ROS Memo Field

• The forwarding of the fields were updated to use a NEW FieldGroupForward table.
• This table allows forwarding of multiple Main Exam Legacy fields into a single New field.
• The software will only go back 5 years to forward information from one Exam to the next.
• It will only forward Legacy fields that do NOT exist on the same tab as the New field that 
   they are being forwarded to.
• It will forward all field values, even those that are Normal values.
• Right click in the memo field and select 'Forward from Last Visit'.
• Below is the list of Legacy fields that will forward into the 'ROS' memo field from a 
   previous date of service:
          • Constitution
          • Cardiovascular
          • ENT
          • Respiratory
          • Gastrointestinal
          • Genitourinary
          • Musculoskeletal
          • Integumentary
          • Neurological
          • Psychiatric
          • Endocrine
          • Hematologic/Lymphatic
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KNOW BEFORE YOU GO
          • Allergic/Immunologic
          • Other
          • Eyes

 X (12.4.0.18) Patient >Command (Group) > Command Moved

• The 'Group' command was moved off of the 'Jump' menu and back to the main menu.

 X (12.4.0.17) Customization >Screen Builder > ALL > Grids Updated to SQL

• In version 12.4.0.16, the option for adding cbsdbgrids and cbsdbfiltergrids was retired.
• Upon update to version 12.4.0.17 and greater, all cbsdbgrid and cbsdbfiltergrid will be 
   updated to sqlgrids. 
• These sqlgrids allow more functionality and flexibility in customization.
• Converting the grids to sqlgrids also provides a performance boost to the software.

 X (12.4.0.17) Exam >2021 E&M Coding > Data Count Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Medical Lab Table – External Lab check box
          • This will no longer be looking directly at this field in the lab table for determination.
          • When the Medical Lab is selected on the patient Exam record, if the 'External Lab' 
             field is 'Y' in the table, it will default that value into the NEW ExamTest.ExternalLab
             check box (see below).
• Exam Test Name Table – External Lab check box
          • This is a NEW field that was added.
          • Used to designate if the Test is performed at an external lab.
          • This will default into the check box (ExamTest.ExternalLab) on the patient Exam 
             record when the Test is selected either manually, or added via Order Set. 

• ExtTestsOrdered
          • Determination
                    • Coding Logic is looking for the number of EHR Tests with 'Ordered' dates 
                       and the 'External Lab' field checked. 
• ExtTestsReviewed
          • Determination
                    • Coding Logic is looking for the number of EHR Tests with 'Reviewed' dates 
                       equal to the Exam date and the 'External Lab' field checked. 
• ExtTestsInterpreted
          • Determination
                    • Coding Logic is looking for the number of EHR Tests with information in the 
                       'Findings' or 'Interpretation' field, 'Reviewed' dates, 'Independent 
                       Interpretation' checked and the 'External Lab' field checked.

 X (12.4.0.17) Exam >2021 E&M Coding > High Risk Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Determination:
          • It is looking at Surgery records with the following:
                    • The 'Historical' field is NOT checked.
                    • Data documented in the 'High Risk' memo field.
                    • The 'Added' date is equal to the Exam date.
          • It is looking at Treatment records with the following:
                    • The 'Historical' field is NOT checked.
                    • Data documented in the 'High Risk' memo field.
                    • The 'Performed' date is equal to the Exam date.
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KNOW BEFORE YOU GO
 X (12.4.0.17) Exam >2021 E&M Coding > Management Level Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Starting 2/22/21 in Version 12.4.0.17: Additional Information:
          • Items below are “Where applicable” based upon your Advantage product:
                    • Determination for Surgery level is based on the following:
                              • The 'Historical' field is NOT checked.
                              • The 'Added' date is equal to the Exam date.
                              • Global Period details for CPT code attached to Surgery/Treatment:
                                        • CPT codes with Global Period between 0 and 10 are 
                                           considered SurgeryMinor.
                                        • CPT codes with Global Period greater than 10 are considered 
                                           SurgeryMajor.

 X (12.4.0.17) Exam >Command (Fees) > EHR Auto Fee Posting Window > Internal 
Counts & Logical Values

• The software, based on what is documented, recommends a coding level using the NEW 
   2021 AMA guidelines. 
• The NEW box in the bottom left corner, displays the 'Internal Counts and Logical Values 
   Determined from Exam Encounter Data which drove the Recommended Coding Level'.
• Internal Counts and Logical Values below will vary based upon product:
          • Problem Level
          • Data Level
          • Management Level
          • External Tests Reviewed
          • External Tests Ordered
          • External Tests Interpreted
          • Historian Comments
          • Discussion Notes
          • Notes Reviewed
          • Rx
          • Over the Counter
          • Self Care
          • Unknown Problem
          • Hospital
          • Risk Factors
          • Surgery: None, Minor or Major
          • Emergency

 X (12.4.0.17) Exam >Tab(s) > EDITED: PopUpCommunication

• Tab Name: PopUpCommunication, Tab Label: Comm

• Provider Discussion field
          • This is a NEW field that was added to identify the Communication records that are 
             'DiscussionNotes'.
          • It is an actual 'conversation' with the external source via phone, text or E-mail, on 
             the same date as the Exam.
          • Upon update, this field will default to False/Unchecked.
          • This must be used for the NEW 2021 E&M Coding engine.

 X (12.4.0.17) Exam >Tab(s) > EDITED: PopUpLab

• Tab Name: PopUpLab, Tab Label: Lab Test
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KNOW BEFORE YOU GO
• External Lab field
          • This is a NEW field that was added to identify the Labs/Tests that were performed 
             at an external lab; this must be used for the NEW 2021 E&M Coding engine.

 X (12.4.0.17) Look-up Tables >EHR > Test > Name > Field(s) ADDED

• External Lab – Used to designate if the Test is usually performed at an external lab; 
   default is blank/False. 
          • This will default into the field on the patient Exam record when the Test is selected 
             either manually, or added via Order Set.

Hot Topics
 (12.4.0.25) Exam > Look-up Tables > Diagnosis > ICD-10 Codes

• The Diagnosis table was updated with the latest ICD-10 Codes for 2022.

 X (12.4.0.24) Exam > Command (E-Rx) > Mandatory Version Update

• Compulink has released a mandatory version update for AdvantageERx users.
• The user interface will see very few changes, however, an industry wide format change 
   will require all of our clients who are currently using AdvantageERx to update to version 
   12.4.0.24 no later than August 31st 2021.
• This release was available as of August 12th 2021.
• Failure to update prior to the deadline will result in AdvantageERx not functioning after 
   August 31st 2021.
• An E-Mail blast with additional information was sent to all clients currently flagged as
  using AdvantageERx.

 X (12.4.0.24) Exam > Command (E-Rx) > NEW Mandatory Information

• Upon update to version 12.4.0.24 and greater, the electronic prescription software will be 
   updated for new certification requirements through Surescripts.
• Due to these new requirements, as soon as you update, electronic prescriptions for 
   patients 17 years and under, require height and weight to be entered on the 'Vitals' panel
   for successful submission.
• This information will display in the Medication Review screen only for these patients.
• NOTE: Although the new certification starts September 1st, if you update prior to that, 
the 
   software is updated, and will be looking for this newly required information; update 
   today, mandatory today.

 (12.4.0.21) Update Education > NEW User Focused Education

• A NEW User Focused Education engine has been added.
• It delivers Profile Right controlled Education directly to your staff.
• For detailed information, see the topic: Education > Update Education > NEW User 
   Focused Education.

 (12.4.0.21) Utility > System Administrator > Login > Profiles

• There's no time like the present to review user permissions in your Profile Rights table.
• With the introduction of the NEW User Focused Education delivering Profile Right 
   controlled Education, you need to make sure that your staff is set up correctly to get the 
   information that they need.
• Visit Compulink University and watch the course: Login Profile Rights

Education
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Education
 (12.4.0.25) Video > EDITED: RPA: Claims Workflow Recommendations

• The Compulink University course 'RPA: Claims workflow Recommendations' was added.
• It can be found under the following Program: BILLING – INSURANCE ACTIVITIES.
• Course Description: Claims workflow recommendations in RPA are covered in this course.
• Published: 3/18/2022 - Length: 6 Minutes

 (12.4.0.25) Video > NEW: AWA: Appointment Scheduling

• The NEW Compulink University course 'AWA: Appointment Scheduling' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: This course teaches attendees the basics of Appointment Scheduling:
   Scheduling, Rescheduling and Canceling Appointments.
• Published: 12/30/2021 - Length: 12 Minutes

 (12.4.0.25) Video > NEW: AWA: Appointment Scheduling

• The NEW Compulink University course 'AWA: Appointment Scheduling' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   NEW CLIENTS.
• Course Description: This course teaches attendees the basics of Appointment Scheduling:
   Scheduling, Rescheduling and Canceling Appointments.
• Published: 12/30/2021 - Length: 7 Minutes

 (12.4.0.25) Video > NEW: AWA: Appointments Setup

• The NEW Compulink University course 'AWA: Appointments Setup' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: This course teaches Established Clients how to setup and manage 
   Appointment-related Tables.
• Published: 12/20/2021 - Length: 10 Minutes

 (12.4.0.25) Video > NEW: AWA: General Table Setup

• The NEW Compulink University course 'AWA: General Table Setup' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: This course teaches Administrators and Management staff the basics 
   of General Table Setup.
• Published: 12/21/2021 - Length: 18 Minutes

 (12.4.0.25) Video > NEW: AWA: Ledger And Insurance Basics

• The Compulink University course 'AWA: Ledger And Insurance Basics' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: This course teaches Established Clients Insurance and Ledger Basics.
• Published: 3/18/2022 - Length: 24 Minutes

 (12.4.0.25) Video > NEW: Accessing Compulink University from Mobile Devices

• The Compulink University course 'Accessing Compulink University from Mobile Devices' 
   was added.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY AND 
   ONLINE HELP.
• Course Description: Accessing Compulink University from a mobile device has never been 
   easier. See what updates have been made to make navigation more efficient.
• Published: 3/15/2022 - Length: 1 Minute
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Education
 (12.4.0.25) Video > NEW: Adding a New Patient

• The Compulink University course 'Adding a New Patient' was added.
• It can be found under the following Program: PATIENT FLOW.
• Course Description: This course covers how to add new patient and account responsible 
   information, add a patient’s picture to their record, scan in an insurance card and scan in 
   a HIPAA agreement.
• Published: 3/15/2022 - Length: 12 Minutes

 (12.4.0.25) Video > NEW: Automating Reports with PracticeWatch

• The Compulink University course 'Automating Reports with PracticeWatch' was added.
• It can be found under the following Program: PRACTICEWATCH.
• Course Description: Review how to set up automated reports and deliver them to staff.
• Published: 3/15/2022 - Length: 6 Minutes

 (12.4.0.25) Video > NEW: CMS Quick Start Guides

• The Compulink University course 'CMS Quick Start Guides' was added.
• It can be found under the following Program: GOVT COMPLIANCE.
• Course Description: Learn how to quickly access the CMS Quick Start Guides for each 
   performance category. This is an easy way to familiarize yourself with the current 
   requirements.
• Published: 3/11/2022 - Length: 2 Minutes

 (12.4.0.25) Video > NEW: Checking in a New Patient

• The Compulink University course 'Checking in a New Patient' was added.
• It can be found under the following Program: PATIENT FLOW.
• Course Description: Review the steps for checking in a patient, including marking their 
   appointment Kept, scanning their insurance card and HIPAA agreement; as well as 
   collecting a co-pay. Print a Patient Information sheet to verify their data is current.
• Published: 3/15/2022 - Length: 12 Minutes

 (12.4.0.25) Video > NEW: Compulink University Course Catalog Shopping Cart

• The Compulink University course 'Compulink University Course Catalog Shopping Cart' 
   was added.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY AND 
   ONLINE HELP.
• Course Description: This brief course outlines the Shopping Cart feature inside Course 
   Catalog in Compulink University. This tool makes registering for courses easy and 
   efficient.
• Published: 3/15/2022 - Length: 1 Minute

 (12.4.0.25) Video > NEW: ELearning Tools and Resources

• The Compulink University course 'Elearning Tools and Resources' was added.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY AND 
   ONLINE HELP.
• Course Description: This course provides an overview of the Education page on our 
   Compulink client website, a brief tour of Compulink University and a look into our Online 
   Help file.
• Published: 3/11/2022 - Length: 23 Minutes

 (12.4.0.25) Video > NEW: Enterprise Task Management

• The Compulink University course 'Enterprise Task Management' was added.
• It can be found under the following Program: PATIENT FLOW.
• Course Description: Learn about the Enterprise Task Management Feature. Task 

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com               10



Education
   Management offers advanced features with abilities to assign Task/Payor Groups in the 
   patient Exam.
• Published: 11/19/2021 - Length: 8 Minutes

 (12.4.0.25) Video > NEW: Financial: Notes Table

• The Compulink University course 'Financial: Notes Table' was added.
• It can be found under the following Program: TABLES – FINANCIAL.
• Course Description: This table stores standard notes or comments that you may wish to 
   include on a patient’s Ledger.
• Published: 3/15/2022 - Length: 4 Minutes

 (12.4.0.25) Video > NEW: Financial: Revenue Codes Table

• The Compulink University course 'Financial: Revenue Codes Table' was added.
• It can be found under the following Program: TABLES – FINANCIAL.
• Course Description: This table is used to store Revenue Codes associated with UB04 
   claims. Revenue codes are 3-digit numbers to identify either where the patient received 
   treatment or what type of treatment was received.
• Published: 3/18/2022 - Length: 3 Minutes

 (12.4.0.25) Video > NEW: Incident to Billing

• The Compulink University course 'Incident to Billing' was added.
• It can be found under the following Program: BILLING – INSURANCE ACTIVITIES.
• Course Description: Learn how to set up the software and post charges using the 
   incident-to-bill feature.
• Published: 11/19/2021 - Length: 4 Minutes

 (12.4.0.25) Video > NEW: Ledger: Posting Charges I

• The Compulink University course 'Ledger: Posting Charges I' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Take a deep dive into the Add/Edit/Insert Charge Posting window. 
   Understanding how to complete this screen is key to accurate ledger posting.
• Published: 11/19/2021 - Length: 25 Minutes

 (12.4.0.25) Video > NEW: Ledger: Posting Charges II

• The Compulink University course 'Ledger: Posting Charges II' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Learn how to post a Service, Material or X-ray charge to your patient 
   ledgers.
• Published: 11/19/2021 - Length: 17 Minutes

 (12.4.0.25) Video > NEW: Ledger: Posting Refunds

• The Compulink University course 'Ledger: Posting Refunds' was added.
• It can be found under the following Program: BILLING – PATIENT - GUARANTOR.
• Course Description: Learn how to post insurance and account responsible refunds, as well
   as how to properly use the Void Entry and Return commands.
• Published: 2/17/2022 - Length: 19 Minutes

 (12.4.0.25) Video > NEW: MACRA: QPP Submission Portal Resources

• The Compulink University course 'MACRA: QPP Submission Portal Resources' was added.
• It can be found under the following Program: GOVT COMPLIANCE.
• Course Description: Briefly review where you go to submit data on the QPP Submission 
   Portal.
• Published: 2/18/2022 - Length: 2 Minutes
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 (12.4.0.25) Video > NEW: New Advantage Help UI

• The Compulink University course 'New Advantage Help UI' was added.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY AND 
   ONLINE HELP.
• Course Description: Check out the changes to Advantage Help! We're sporting a new 
   contemporary look for our users interface which promotes improved readability.
• Published: 2/1/2022 - Length: 3 Minutes

 (12.4.0.25) Video > NEW: Posting Payment Transfers

• The Compulink University course 'Posting Payment Transfers' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Walk through how to transfer payments, both within the same ledger 
   account or to other patient accounts.
• Published: 2/18/2022 - Length: 5 Minutes

 (12.4.0.25) Video > NEW: PracticeWatch: Create a Distribution Group

• The Compulink University course 'PracticeWatch: Create a Distribution Group' was added.
• It can be found under the following Program: PRACTICEWATCH.
• Course Description: Review editing, removing, deleting, creating and attaching a 
   Distribution List to a PracticeWatch Task.
• Published: 2/18/2022 - Length: 10 Minutes

 (12.4.0.25) Video > NEW: PracticeWatch: Populate Report Data for the Quality 
Payment

• The Compulink University course 'PracticeWatch: Populate Report Data for the Quality 
   Payment' was added.
• It can be found under the following Program: PRACTICEWATCH.
• Course Description: Review how to automate populating the Quality Report Data with 
   PracticeWatch. Includes adding and scheduling a Promoting Interoperability (PI) Report.
• Published: 3/15/2022 - Length: 13 Minutes

 (12.4.0.25) Video > NEW: Prescription Drug Monitoring Program (PDMP)

• The Compulink University course 'AdvantageERx: Prescription Drug Monitoring Program 
   (PDMP)' was added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
• Course Description: Review the Prescription Drug Monitoring Program (PDMP) set up and 
   functionality.
• Published: 12/2/2021 - Length: 6 Minutes

 (12.4.0.25) Video > NEW: Receivables Advisor Form CHC (Formerly ExpressBill)

• The Compulink University course 'Receivables Advisor Form CHC (Formerly ExpressBill)' 
   was added.
• It can be found under the following Program: BILLING – PATIENT - GUARANTOR.
• Course Description: Learn how to request Receivables Advisor services and how the install
and setup processes work. We’ll also review the process for preparing both Recalls and 
Statements, and walk through accessing the FileZilla software for the file transfer process. 
• Published: 2/17/2022 - Length: 17 Minutes

 (12.4.0.25) Video > NEW: Receivables Advisor from Change Healthcare 
(ExpressBill)

• The Compulink University course 'Receivables Advisor from Change Healthcare 
   (ExpressBill)' was added.
• It can be found under the following Program: BILLING – PATIENT - GUARANTOR.
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• Course Description: Learn what Receivables Advisor can do for your practice, how to 
   request services and what's involved in the setup and implementation process.
• Published: 11/19/2021 - Length: 5 Minutes

 (12.4.0.25) Video > NEW: Text Message with PracticeWatch

• The Compulink University course 'Text Message with PracticeWatch' was added.
• It can be found under the following Program: PRACTICEWATCH.
• Course Description: Review how to set up Text Messages to patients and staff with 
   PracticeWatch.
• Published: 3/15/2022 - Length: 7 Minutes

 (12.4.0.24) Video > NEW/UPDATED: AdvantageERx: E-Prescribing Workflow

• The Compulink University course 'AdvantageERx: E-Prescribing Workflow' was added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
• Course Description: Workflow for Prescribers and Staff assisting with e-Prescribing 
   medications. Includes: ERx History, Plan Eligibility, Standard Medication, Formulary 
   Section, Screen, Review, Transmit Rx, EPA and Canceling the Prescription. 
• Published: 9/17/2021 (Re-Published 10/15) - Length: 22 Minutes

 (12.4.0.24) Video > NEW/UPDATED: AdvantageERx: Tools

• The Compulink University course 'AdvantageERx: Tools' was added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
• Course Description: Reviews: Pharmacy Search window Edit, Sign, Change, Education, 
   Refresh, Utility, Refill, eRx Worklists, Patient Connect, Reports and AdvantageERx 
   Dashboard.
• Published: 10/1/2021 (Re-Published 10/27) - Length: 20 Minutes

 (12.4.0.24) Video > NEW/UPDATED: Creating Student Accounts in Compulink 
University

• The Compulink University course 'Creating Student Accounts in Compulink University' was
   updated.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY.
• Course Description: Briefly review the table setup requirements for creating a student 
   account and how to log in to Compulink University.
• Published: 11/12/2021 (Re-Published 11/18/21) - Length: 3 Minutes

 (12.4.0.24) Video > NEW/UPDATED: Education Menu on the Client Web Portal

• The Compulink University course 'Education Menu on the Client Web Portal' was added.
• It can be found under the following Program: ADVANTAGE AT A GLANCE.
• Course Description: Take a Tour of the Education Menu on the Client Web Portal.
• Published: 9/10/2021 (Re-Published 9/17) - Length: 3 Minutes

 (12.4.0.24) Video > NEW/UPDATED: Touch Screen & Tablet Functionality

• The NEW Compulink University course 'Touch Screen & Tablet Functionality' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: Review special functionality available for Touch Screen monitors and 
   Tablets.
• Published: 10/19/2021 (Re-Published 11/3/21) - Length: 3 Minutes

 (12.4.0.24) Video > NEW: 2021 PI E-Prescribing Objective

• The Compulink University course '2021 PI E-Prescribing Objective' was added.
• It can be found under the following Program: MACRA QUALITY PAYMENT PROGRAMS.
• Course Description: Review the measures within the e-Prescribing objective and learn 
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   which data points in your Advantage software are documented to meet the specifications.
• Published: 9/10/2021 - Length: 7 Minutes

 (12.4.0.24) Video > NEW: 2021 PI Health Information Exchange Objective

• The Compulink University course '2021 PI Health Information Exchange Objective' was 
   added.
• It can be found under the following Program: MACRA QUALITY PAYMENT PROGRAMS.
• Course Description: Review the measures within the Health Information Exchange 
   objective and learn which data points in your Advantage software are documented to 
   meet the specifications.
• Published: 9/10/2021 - Length: 22 Minutes

 (12.4.0.24) Video > NEW: 2021 PI Protect Patient Health Information Objective

• The Compulink University course '2021 PI Protect Patient Health Information Objective' 
   was added.
• It can be found under the following Program: MACRA QUALITY PAYMENT PROGRAMS.
• Course Description: Review the measure within the Protect Patient Health Information 
   objective and learn which measure specifications relate to your Advantage software.
• Published: 9/17/2021 - Length: 16 Minutes

 (12.4.0.24) Video > NEW: 2021 PI Public Health/Clinical Data Exchange Objective

• The Compulink University course '2021 PI Public Health/Clinical Data Exchange Objective' 
   was added.
• It can be found under the following Program: MACRA QUALITY PAYMENT PROGRAMS.
• Course Description: Review the measures within the Public Health and Clinical Data 
   Exchange objective. Navigate to the Registries & HIE Interface Request page on the 
   Compulink Client Web Portal. 
• Published: 9/17/2021 - Length: 19 Minutes

 (12.4.0.24) Video > NEW: 2021 Promoting Interoperability Provider to Patient 
Exchange Objective

• The Compulink University course '2021 Promoting Interoperability Provider to Patient 
   Exchange Objective' was added.
• It can be found under the following Program: MACRA QUALITY PAYMENT PROGRAMS.
• Course Description: Review the measures within the Provider to Patient Exchange 
   objective and learn which data points in your Advantage software are documented to 
   meet the specifications.
• Published: 9/30/2021 - Length: 8 Minutes

 (12.4.0.24) Video > NEW: AWA To Onboard New Staff

• The NEW Compulink University course 'AWA To Onboard New Staff' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: Activate with Advantage for Established Clients offers an interactive 
   format that is effective for onboarding new staff or as a refresher for all users. 
• Published: 9/17/2021 - Length: 3 Minutes

 (12.4.0.24) Video > NEW: AWA: Contact Lens Workflow (Established)

• The NEW Compulink University course 'AWA: Contact Lens Workflow' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: This course assists Established Users in creating and managing 
   Contact Lens records, Orders and more.
• Published: 10/28/2021 - Length: 10 Minutes
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 (12.4.0.24) Video > NEW: AWA: Contact Lens Workflow (New)

• The NEW Compulink University course 'AWA: Contact Lens Workflow' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   NEW CLIENTS.
• Course Description: This course assists New Users in creating and managing Contact Lens
   records, Orders and more.
• Published: 10/28/2021 - Length: 11 Minutes

 (12.4.0.24) Video > NEW: AWA: Orientation And Product Briefing

• The NEW Compulink University course 'AWA: Orientation And Product Briefing' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   NEW CLIENTS.
• Course Description: This course is an overview of the self-paced eLearning tool for new 
   Advantage users who want a quick and comprehensive implementation.
• Published: 10/28/2021 - Length: 5 Minutes

 (12.4.0.24) Video > NEW: Account Management Tools>Before And After Billing

• The Compulink University course 'Account Management Tools > Before And After Billing' 
   was added.
• It can be found under the following Program: BILLING – INSURANCE ACTIVITIES.
• Course Description: Learn about the many tools available to manage your accounts 
   including Reports, Worklists and Payor Notes
• Published: 9/24/2021 - Length: 16 Minutes

 (12.4.0.24) Video > NEW: AdvantageERx: EPCS – Controlled Substances

• The Compulink University course 'AdvantageERx: EPCS – Controlled Substances' was 
   added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
• Course Description: Review EPCS Workflow and information.
• Published: 10/28/2021 - Length: 12 Minutes

 (12.4.0.24) Video > NEW: AdvantageERx: Electronic Prior Authorization

• The Compulink University course 'AdvantageERx: Electronic Prior Authorization' was 
   added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
• Course Description: Review ePA Workflow and options.
• Published: 10/19/2021 - Length: 11 Minutes

 (12.4.0.24) Video > NEW: AdvantageERx: How To Disable EPCS

• The Compulink University course 'AdvantageERx: How To Disable EPCS' was added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
• Course Description: Learn what to do if a Provider's EPCS credentials are compromised. 
• Published: 10/8/2021 - Length: 7 Minutes

 (12.4.0.24) Video > NEW: AdvantageERx: IdenTrust Registration

• The Compulink University course 'AdvantageERx: IdenTrust Registration' was added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
• Course Description: Review the IdenTrust Registration Process.
• Published: 10/19/2021 - Length: 7 Minutes

 (12.4.0.24) Video > NEW: AdvantageERx: Introduction

• The Compulink University course 'AdvantageERx: Introduction' was added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
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• Course Description: For practices on-boarding or migrating from New Crop to 
   AdvantageERx. Provides a general overview of the project from start to finish and how to 
   prepare.
• Published: 9/10/2021 - Length: 11 Minutes

 (12.4.0.24) Video > NEW: AdvantageERx: Overview (w/Admin Setup)

• The Compulink University course 'AdvantageERx: Overview (w/Admin Setup)' was added.
• It can be found under the following Program: E-PRESCRIBING-ADVANTAGEERx.
• Course Description: Administrative set up for AdvantageERx. Includes: Login Tables, 
   Location Details, Provider and E-Rx Provider Tables, Test environment and Server Test 
   Command.
• Published: 9/17/2021 - Length: 19 Minutes

 (12.4.0.24) Video > NEW: AdvantageRCM Fee Calculation Report

• The Compulink University course 'AdvantageRCM Fee Calculation Report' was added.
• It can be found under the following Program: REPORTS.
• Course Description: Learn how this report identifies RCM eligible payments that are used 
   to determine your monthly RCM fees.
• Published: 10/1/2021 - Length: 7 Minutes

 (12.4.0.24) Video > NEW: BETA Production by Primary Payor Report

• The Compulink University course 'BETA Production by Primary Payor Report' was added.
• It can be found under the following Program: REPORTS.
• Course Description: This report evaluates charges by Primary Payor with payments, 
   adjustments, transfers and refunds applied. Learn how to provide input during the report 
   BETA period. 
• Published: 9/30/2021 - Length: 5 Minutes

 (12.4.0.24) Video > NEW: CU For The Administrator: Exam Results & Analysis 
Reports

• The Compulink University course 'CU For The Administrator: Exam Results & Analysis 
   Reports' was added.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY.
• Course Description: This course will show how to run the Exam Results Report, as well as 
   to be able to further analyze Exam Results.
• Published: 10/29/2021 - Length: 3 Minutes

 (12.4.0.24) Video > NEW: CU For The Administrator: Manager Reports

• The Compulink University course 'CU For The Administrator: Manager Reports' was added.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY.
• Course Description: Learn how to run the Manager Reports available to the Administrator 
   in the Admin Portal. A sample of each report will be show during the session.
• Published: 10/28/2021 - Length: 10 Minutes

 (12.4.0.24) Video > NEW: EHR Field Edit Level

• The Compulink University course 'EHR Field Edit Level' was added.
• It can be found under the following Program: CUSTOMIZATION.
• Course Description: Login Profile Right: EHR Field Edit Level.
• Published: 9/17/2021 - Length: 3 Minutes

 (12.4.0.24) Video > NEW: EHR Multiple Users Accessing One Exam

• The Compulink University course 'EHR Multiple users Accessing One Exam' was added.
• It can be found under the following Program: ELECTRONIC HEALTH RECORDS.
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• Course Description: Multiple Users can document in the same medical record 
   simultaneously.
• Published: 10/8/2021 - Length: 4 Minutes

 (12.4.0.24) Video > NEW: Electronic Faxing Setup > Updox

• The NEW Compulink University course 'Electronic Faxing Setup > Updox' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: Take a quick look at the setup required to send/receive electronic 
   faxes with your Advantage software using Updox.
• Published: 8/27/2021 - Length: 4 Minutes

 (12.4.0.24) Video > NEW: GUI Customization

• The Compulink University course 'GUI Customization' was added.
• It can be found under the following Program: CUSTOMIZATION.
• Course Description: Learn how you can customize the colors of your GUI and toolbar 
   icons.
• Published: 11/12/2021 - Length: 4 Minutes

 (12.4.0.24) Video > NEW: Insurance Related Worklists

• The Compulink University course 'Insurance Related Worklists' was added.
• It can be found under the following Program: BILLING – INSURANCE ACTIVITIES.
• Course Description: A review of the following Insurance related worklists: Post Payment 
   Statement Review, Insurance Receivable Aging and Insurance Unbilled Charges.
• Published: 7/23/2021 - Length: 3 Minutes

 (12.4.0.24) Video > NEW: MACRA: Compulink Advantage 2021 Reports

• The Compulink University course 'MACRA: Compulink Advantage 2021 Reports' was 
   added.
• It can be found under the following Program: MACRA QUALITY PAYMENT PROGRAMS.
• Course Description: This course reviews the 2021 MACRA/MIPS, 2021 Patient List, 2021 
   Simple List and 2021 QPP.
• Published: 10/28/2021 - Length: 25 Minutes

 (12.4.0.24) Video > NEW: Overview: 2021 MIPS Category of Promoting 
Interoperability

• The Compulink University course 'Overview: 2021 MIPS Category of Promoting 
   Interoperability' was added.
• It can be found under the following Program: MACRA QUALITY PAYMENT PROGRAMS.
• Course Description: Briefly review the category definitions and scoring information for the
   Promoting Interoperability objectives. 
• Published: 9/10/2021 - Length: 6 Minutes

 (12.4.0.24) Video > NEW: Patient Referrals: Authorizations or Tracking Visits

• The Compulink University course 'Patient Referrals: Authorizations or Tracking Visits' was 
   added.
• It can be found under the following Program: PATIENT FLOW.
• Course Description: Learn how to add referral records used to track insurance 
authorizations, including how to use the visit tracker to monitor visits incurred.
• Published: 9/24/2021 - Length: 9 Minutes

 (12.4.0.24) Video > NEW: Receiving Electronic Faxes

• The NEW Compulink University course 'Receiving Electronic Faxes' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
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• Course Description: Take a tour of the InBox and learn how to receive incoming E-Faxes 
   into your Advantage software.
• Published: 8/27/2021 - Length: 5 Minutes

 (12.4.0.24) Video > NEW: Referrals: Patient to Patient and Advertising

• The Compulink University course 'Referrals: Patient to Patient and Advertising' was added.
• It can be found under the following Program: PATIENT FLOW.
• Course Description: Walk through examples of adding patient referrals for the purpose of 
   tracking advertising or marketing venues and adding referrals for existing patients 
   referring new patients to the office. 
• Published: 9/17/2021 - Length: 6 Minutes

 (12.4.0.24) Video > NEW: Revenue with Flexible Grouping Report

• The Compulink University course 'Revenue with Flexible Grouping Report' was added.
• It can be found under the following Program: REPORTS.
• Course Description: Learn how to customize report views to evaluate your revenue.
• Published: 10/19/2021 - Length: 10 Minutes

 (12.4.0.24) Video > NEW: SMART Orders Window

• The Compulink University course 'SMART Orders Window' was added.
• It can be found under the following Program: ELECTRONIC HEALTH RECORDS.
• Course Description: See how the SMART Orders functionality can streamline the selection 
   of Assessments, Plans and Orders, based on your patient’s diagnosis.
• Published: 9/24/2021 - Length: 5 Minutes

 (12.4.0.24) Video > NEW: Transfer E-Fax To Wrong Account

• The Compulink University course 'Transfer E-Fax To Wrong Account' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: Learn how to correct an incoming fax that was accidentally 
   transferred to the wrong patient account.
• Published 8/31/2021 - Length: 3 Minutes

 (12.4.0.24) Video > NEW: User Lock-Out And Password Management

• The Compulink University course 'User Lock-Out and Password Management' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: Discover how passwords can be reset, both on-demand options and 
   automated. Learn about User Lock-Out options and how to deactivate User accounts.
• Published 11/12/2021 - Length: 9 Minutes

 (12.4.0.24) Video > NEW: eLearning Tools And Resources

• The Compulink University course 'eLearning Tools And Resources' was added.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY.
• Course Description: This course provides an overview of the Education page on our 
   Compulink client website, a brief tour of Compulink University and a look into our Online 
   Help file.
• Published: 9/24/2021 - Length: 23 Minutes

 (12.4.0.24) Video > UPDATED: Compulink University For The Administrator: Setup
Student Accounts

• The Compulink University course 'CU For The Administrator: Setup Student Accounts' was
   updated.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY.
• Course Description: This course covers how to add Student Accounts to the Learning 
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   Management System through the Login IDs table of the Advantage Software.
• Re-Published: 11/30/2021 - Length: 5 Minutes

 (12.4.0.24) Video > UPDATED: Compulink University Quick Start

• The Compulink University course 'Compulink University Quick Start' was updated.
• It can be found under the following Program: ADVANTAGE AT A GLANCE.
• Course Description: Take a quick look at how to log in to Compulink University and 
   register for courses.
• Re-Published: 9/24/2021 - Length: 7 Minutes

 (12.4.0.24) Video > UPDATED: Navigating Version Release Notes

• The Compulink University course 'Navigating Version Release Notes' was updated.
• It can be found under the following Program: ADVANTAGE AT A GLANCE.
• Course Description: This course introduces Users to great new navigation tools for 
   utilizing Version Release Notes. 
• Re-Published: 9/17/2021 - Length: 5 Minutes

 (12.4.0.24) Video > UPDATED: Overview of What is New in V12.4

• The Compulink University course 'Overview of What is New in V12.4' was updated.
• It can be found under the following Program: ABOUT VERSION 12.4.
• Course Description: Learn about new changes and upgrades coming in V12.4 in this 
   Overview course. It touches on the changes needed for 2021 E&M Coding, an upgrade to 
   the PracticeWatch System and an introduction to the LibreOffice interface option.
• Re-Published: 10/29/2021 - Length: 21 Minutes

 (12.4.0.24) Video > UPDATED: Smart Function Editor

• The Compulink University course 'Smart Function Editor' was updated.
• It can be found under the following Program: CUSTOMIZATION.
• Course Description: This course reviews the Smart Function Editor table.
• Re-Published: 10/27/2021 - Length: 14 Minutes

 (12.4.0.24) Video > UPDATED: V12.4 EHR: Know Before You Go

• The Compulink University course 'V12.4 EHR: Know Before You Go' was updated.
• It can be found under the following Program: ABOUT VERSION 12.4.
• Course Description: This course provides an overview of the Version 12.4 EHR and optical 
   enhancements for Eyecare and Ophthalmology Advantage.
• Re-Published: 10/29/2021 - Length: 15 Minutes

 (12.4.0.22) Video > NEW: Configuring Users for Exam Access

• The NEW Compulink University course 'Configuring Users for Exam Access' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: Overview course on Configuring Users for Exam Access in the Login 
   IDs, Login Right Profiles and System Setup areas. 
• Published: 8/20/2021 - Length: 23 Minutes

 (12.4.0.22) Video > NEW: Direct E-Mail Receive Function

• The Compulink University course 'Direct E-Mail Receive Function' was added.
• It can be found under the following Program: FUNCTIONS – BATCH PROCESSES.
• Course Description: A review of how the Direct E-Mail Receive Functions imports CCDs 
   into your software and provides instructions on how to reconcile CCDs to your patient 
   records.
• Published: 8/12/2021 - Length: 10 Minutes

 (12.4.0.22) Video > NEW: E-Faxing in Advantage Overview
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• The NEW Compulink University course 'E-Faxing in Advantage Overview' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: Let's take a bird's eye view of how Electronic Faxing with Updox 
   works in your Advantage software.
• Published: 8/20/2021 - Length: 4 Minutes

 (12.4.0.22) Video > NEW: Financial: Billing IDs Table

• The Compulink University course 'Financial: Billing IDs Table' was added.
• It can be found under the following Program: TABLES - FINANCIAL.
• Course Description: Learn when entries might be needed in the Billing IDs table, and how
   to complete the data entry fields.
• Published: 7/23/2021 - Length: 9 Minutes

 (12.4.0.22) Video > NEW: Financial: Collection Tables

• The Compulink University course 'Financial: Collection Tables' was added.
• It can be found under the following Program: TABLES - FINANCIAL.
• Course Description: Learn the purpose of each of the Collection tables and how to 
   complete them.
• Published: 7/23/2021 - Length: 6 Minutes

 (12.4.0.22) Video > NEW: Ledger: Advance Payments

• The Compulink University course 'Ledger: Advance Payments' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Learn how to accept Prepayments without having Unapplied 
   payments in your patient ledgers.
• Published: 8/12/2021 - Length: 4 Minutes

 (12.4.0.22) Video > NEW: Ledger: Collection Accounts

• The Compulink University course 'Ledger: Collection Accounts' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Explore the Ledger Collection module with efficiency tools designed to
   manage your overdue patient accounts.
• Published: 7/29/2021 - Length: 9 Minutes

 (12.4.0.22) Video > NEW: Ledger: Collection Setup

• The Compulink University course 'Ledger: Collection Setup' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Learn what setup is required to support the Collection Tracking 
   module in patient ledgers.
• Published: 8/12/2021 - Length: 6 Minutes

 (12.4.0.22) Video > NEW: Ledger: Payor Notes

• The Compulink University course 'Ledger: Payor Notes' was added.
• It can be found under the following Program: LEDGER.
• Course Description: This brief tutorial presents the Ledger Payor Notes functionality with 
   the companion RCM Insurance Follow-up Worklist.
• Published: 8/12/2021 - Length: 4 Minutes

 (12.4.0.22) Video > NEW: Ledger: Posting From EHR

• The Compulink University course 'Ledger: Posting From EHR' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Walk through the steps of posting charges to a patient ledger from 
   the EHR.
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• Published: 8/12/2021 - Length: 2 Minutes

 (12.4.0.22) Video > NEW: Multiple Location Login and Setup Details

• The NEW Compulink University course 'Multiple Location Login and Setup Details' was 
   added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: To seamlessly transition to multiple Locations within the software, 
   there are detailed steps to complete prior to use.
• Published: 8/20/2021 - Length: 5 Minutes

 (12.4.0.22) Video > NEW: Reimbursement Analysis Report

• The Compulink University course 'Reimbursement Analysis Report' was added.
• It can be found under the following Program: REPORTS.
• Course Description: The Reimbursement Analysis report allows you to see how well you 
   are being reimbursed for a particular CPT code or overall.
• Published: 7/29/2021 - Length: 6 Minutes

 (12.4.0.22) Video > NEW: Reimbursement Detail Report

• The Compulink University course 'Reimbursement Detail Report' was added.
• It can be found under the following Program: REPORTS.
• Course Description: This report provides a view of reimbursements and adjustments at 
   the individual Charge level.
• Published: 7/29/2021 - Length: 5 Minutes

 (12.4.0.21) Update Education > NEW User Focused Education

• We understand that each update can be overwhelming in the amount of changes 
   contained within our comprehensive Version Release Notes and Service Pack documents, 
   and the information does not always get to the right people in a timely fashion.
• To assist with this, a new User Focused Education engine has been created, and will 
   download those same education items on a weekly basis, right to your Advantage 
   software.
• This new capability will allow you to review items that pertain to your job role in the 
   practice (as defined by your access rights) in small, bite-sized pieces, at your 
   convenience.
• An Education icon has been added to the bottom right side of your screen (once you enter
   the patient area).
• If this ICON is YELLOW, you have Pending Education items related to recent/future 
   updates that have been selected based upon your Login Access Rights, and have not yet 
   been reviewed!
• After this information is reviewed, it will continue to remain in your personalized 
   education list for reference. 
• We hope you find this helpful in staying on top of our continued enhancements to make 
   your work easier!
• A reminder about these educational items will pop up upon Login every 90 days, only if 
   there are items that have not yet been marked as Reviewed.

 (12.4.0.21) Update Education > User Focused Education Window

• Click on the 'Update Education' icon in the bottom right of the screen to open the 'Select 
   Update Education Item to Review' window. 
• Information displayed includes the following:
          • Updated – Last date the education item was updated.
          • Version – Advantage software version the item was introduced in.
          • Know Before – Important items for your office to review PRIOR TO UPDATING to 
             the specified version. Look for screen, table and other changes that might affect 

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com               21



Education
             your workflow.
          • Priority – Additional important/priority items added for the specified version.
          • Subject – Subject of the education item (similar to the Version Release Notes and 
             Service Pack Documents).
          • Reviewed – Date and Time item was marked Reviewed by the user.
• Education items are sorted in the following order:
          • Version
                    • Oldest items at the top to newest items at the bottom.
                    • This will assure that you are getting the information in the proper order.
          • Know Before (within that Version)
          • Important (within that Version)
          • Subject (within that Version)
• Double click an education item to open the 'Information' window.
          • After reviewing the information, click 'Yes' to indicate REVIEWED, otherwise 'No'.
          • If 'No' is selected, the window closes and nothing changes.
          • If 'Yes' is selected, the window closes and the current date and time are entered 
             into the 'Reviewed' column to the right of the Subject that was reviewed.

 (12.4.0.21) Video > .Reminder

• This is just a reminder to take a look at the program: ADVANTAGE AT A GLANCE.
• It contains micro-learning videos that are a snapshot of functionality from different areas 
   of your Advantage software.
• Take a minute or two to learn something new!

 (12.4.0.21) Video > NEW: EDI: What is RPA?

• The Compulink University course 'EDI: What is RPA?' was added.
• It can be found under the following Program: EDI - ELIGIBILITY CLAIMS REMITTANCE.
• Course Description: Take a brief tour of Change Healthcare's newest revenue cycle 
   management system, RPA, and learn about the benefits of utilizing RPA. 
• Published: 6/2/2021 - Length: 5 Minutes

 (12.4.0.21) Video > NEW: Group Scheduling Setup

• The Compulink University course 'Group Scheduling Set Up' was added.
• It can be found under the following Program: GROUP SCHEDULING.
• Course Description: Reviews the Group table set up for Group Scheduling.
• Published: 7/2/2021 - Length: 7 Minutes

 (12.4.0.21) Video > NEW: Group Scheduling Workflow

• The Compulink University course 'Group Scheduling Workflow' was added.
• It can be found under the following Program: GROUP SCHEDULING.
• Course Description: Reviews the Workflow of Group Scheduling.
• Published: 7/2/2021 - Length: 10 Minutes

 (12.4.0.21) Video > NEW: Portal Communications Function

• The Compulink University course 'Portal Communications Function' was added.
• It can be found under the following Program: FUNCTIONS – BATCH PROCESSES.
• Course Description: Learn how to run the function, what processes are working in the 
   background and see where incoming messages from the Patient Portal are recorded.
• Published: 7/2/2021 - Length: 8 Minutes

 (12.4.0.21) Video > NEW: PracticeWatch: General Overview

• The Compulink University course 'PracticeWatch: General Overview' was added.
• It can be found under the following Program: PRACTICEWATCH.
• Course Description: Covers PracticeWatch (PW) functionality, configuring System Setup 
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   Parameter, installation and review of the PW service and overview of the PW Dashboard 
   commands.
• Published: 7/9/2021 - Length: 18 Minutes

 (12.4.0.21) Video > NEW: RPA: Claims Workflow Recommendations

• The Compulink University course 'Claims Workflow Recommendations' was added.
• It can be found under the following Program: EDI - ELIGIBILITY CLAIMS REMITTANCE.
• Course Description: Claims workflow recommendations in RPA are covered in this course.
• Published: 6/9/2021 - Length: 6 Minutes

 (12.4.0.21) Video > NEW: RPA: ERA/Payment Workflow Recommendations

• The Compulink University course 'ERA/Payment Workflow Recommendations' was added.
• It can be found under the following Program: EDI - ELIGIBILITY CLAIMS REMITTANCE.
• Course Description: This is a brief look at ERA/Payment Workflow Recommendations in 
   RPA.
• Published: 6/9/2021 - Length: 2 Minutes

 (12.4.0.21) Video > NEW: SMART Orders Setup

• The Compulink University course 'SMART Orders Setup' was added.
• It can be found under the following Program: ELECTRONIC HEALTH RECORDS.
• Course Description: Let's review how the Assessments, Plans and Order Sets get 
   connected to Diagnoses in the SMART Orders window.
• Published: 7/1/2021 - Length: 5 Minutes

 (12.4.0.21) Video > NEW: User Focused Education

• The Compulink University course 'User Focused Education' was added.
• It can be found under the following Program: ABOUT VERSION 12.4.
• Course Description: Our new User Focused Education engine delivers information about 
   the latest software enhancements directly to your desktop, available beginning with 
   V12.4.0.21. 
• Published: 5/26/2021 - Length: 4 Minutes

 (12.4.0.20) Video > NEW: Automating Communications: Patient Contacts & 
Referrals

• The NEW Compulink University course 'Automating Communications: Patient Contacts & 
   Referrals' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: With some simple setup, after visit summaries and other documents 
   can be sent automatically upon sign-off of the patient's exam. 
• Published: 6/4/2021 - Length: 5 Minutes

 (12.4.0.20) Video > NEW: Exam Locate Command

• The Compulink University course 'Exam Locate Command' was added.
• It can be found under the following Program: ELECTRONIC HEALTH RECORDS.
• Course Description: The Exam > Locate menu offers different options for searching the 
   Patient’s Exam records.
• Published: 5/21/2021 - Length: 4 Minutes

 (12.4.0.20) Video > NEW: Financial: GL and AP Tables

• The Compulink University course 'Financial: GL and AP Tables' was added.
• It can be found under the following Program: TABLES - FINANCIAL.
• Course Description: This course reviews the following financial tables under the G/L and 
   AP menu: Chart of Accounts, Mapping Table, GL Interface Mapping Table and the AP 
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   Interface Mapping Table.
• Published: 5/26/2021 - Length: 13 Minutes

 (12.4.0.20) Video > NEW: Insurance Adjustment Analysis Report

• The Compulink University course 'Insurance Adjustment Analysis Report' was added.
• It can be found under the following Program: REPORTS.
• Course Description: The Insurance Adjustments Report helps you identify the types of 
   Adjustments being posted for Primary Payors.
• Published: 6/9/2021 - Length: 7 Minutes

 (12.4.0.20) Video > NEW: Login Profile Rights

• The NEW Compulink University course 'Login Profile Rights' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: This course reviews the importance of correctly assigning staff 
   permission in your Login Profiles. It also outlines tips for success to help you get started. 
• Published: 5/20/2021 - Length: 3 Minutes

 (12.4.0.20) Video > NEW: Login Tables

• The Compulink University course 'Login Tables' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: Learn the importance of creating proper Login Profiles for your users. 
   Take a deep dive into the field definitions in the Login IDs table and understand the 
   importance of the Login credentials you establish for your users. 
• Published: 5/26/2021 Length: 26 Minutes

 (12.4.0.20) Video > NEW: New Field Definition Command In EHR

• The Compulink University course 'New Field Definition Command In EHR' was added.
• It can be found under the following Program: ABOUT VERSION 12.4.
• Course Description: Quickly find exam field information for custom screens, SQL 
   worklists and Crystal Reports using this new right click option. 
• Published: 5/20/2021 - Length: 2 Minutes

 (12.4.0.20) Video > NEW: Psych Advantage Workflow For Therapists

• The Compulink University course 'Psych Advantage Workflow For Therapists' was added.
• It can be found under the following Program: ELECTRONIC HEALTH RECORDS.
• Course Description: This course reviews a New Client Intake and Treatment Service Plan 
   Workflow for Therapists.
• Published: 6/11/2021 - Length: 14 Minutes

 (12.4.0.20) Video > NEW: Re-Billing an Insurance Claim

• The Compulink University course 'Re-Billing an Insurance Claim' was added.
• It can be found under the following Program: BILLING – INSURANCE ACTIVITIES.
• Course Description: This course briefly reviews your options for setting a claim to be re-
   billed.
• Published: 5/21/2021 - Length: 2 Minutes

 (12.4.0.20) Video > NEW: Running Diagnostics

• The Compulink University course 'Running Diagnostics' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: This course will discuss running the Diagnostics Utility, walk through 
   the process and the files that are accessed. A review of the Diag.Log file and Auto 
   Diagnostics is included. 
• Published: 5/21/2021 - Length: 14 Minutes
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 (12.4.0.16) Video > NEW: Signature Update

• The NEW Compulink University course 'Signature Update' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: Learn about the Signature Update feature added in V12.4.0.16.
• Published: 11/12/2021 - Length: 2 Minutes

2021 Evaluation & Management
 X (12.4.0.18) 2021 E&M Coding > Data Count Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Discussion Notes
          • Determination
                    • Coding Logic is looking for a Communication record with the following:
                              • Added date equal to the Exam date 
                              • The NEW 'Provider Discussion' field CHECKED 
                              • EMPTY Reviewed date 
• NotesReviewed
          • Determination
                    • Coding Logic is looking for a Communication record with the following:
                              • Added date equal to the Exam date 
                              • The NEW 'Provider Discussion' field UNCHECKED
                              • Reviewed date equal to the Exam date

 X (12.4.0.18) 2021 E&M Coding > Hospitalization Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• In Versions 12.4.0.16, 12.4.0.17 and SOME of 12.4.0.18, Hospitalization was determined 
   by the 'Place of Service' field being equal to one of the following:
          • Inpatient Hospital 
          • Outpatient Hospital 
          • Emergency Room-Hospital
• Starting 3/3/21 in Version 12.4.0.18, Hospitalization will be determined by the following:
          • EHR Order added with a Name starting with 'REFERRAL TO ED/HOSPITAL'.
          • It may be practice specific like 'REFERRAL TO ED/HOSPITAL FOR FRACTURE', but 
             MUST start with 'REFERRAL TO ED/HOSPITAL'.

 X (12.4.0.18) 2021 E&M Coding > Management Level Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Starting 3/3/21 in Version 12.4.0.18: Additional Information:
          • Place of Service determination (Hospital options) HAS CHANGED TO:
          • EHR Order added with a Name starting with 'REFERRAL TO ED/HOSPITAL'.

• Starting 3/3/21 in Version 12.4.0.18: Management Level Determination:
          • Level 4/High
                    • (Medication prescribed AND High Risk memo field documented) or (EHR 
                       Order entered with criteria equal to Component: Non-Drug Rx Prescribed 
                       AND High Risk memo field documented)
                    • EHR Order added with a Name starting with 'REFERRAL TO ED/HOSPITAL'.
                       OR 
                    • Emergency (Diagnosis Severity=Urgent/Emergent)
                       OR
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                    • Major Surgery AND High Risk memo field documented

 X (12.4.0.18) 2021 E&M Coding > Place of Service Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• In Versions 12.4.0.16, 12.4.0.17 and SOME of 12.4.0.18, Hospitalization was determined 
   by the 'Place of Service' field being equal to one of the following:
          • Inpatient Hospital 
          • Outpatient Hospital 
          • Emergency Room-Hospital
• Starting 3/3/21 in Version 12.4.0.18, Hospitalization will be determined by the following:
          • EHR Order added with a Name starting with 'REFERRAL TO ED/HOSPITAL'.
          • It may be practice specific like 'REFERRAL TO ED/HOSPITAL FOR FRACTURE', but 
             MUST start with 'REFERRAL TO ED/HOSPITAL'.

 X (12.4.0.17) 2021 E&M Coding > Data Count Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Medical Lab Table – External Lab check box
          • This will no longer be looking directly at this field in the lab table for determination.
          • When the Medical Lab is selected on the patient Exam record, if the 'External Lab' 
             field is 'Y' in the table, it will default that value into the NEW ExamTest.ExternalLab
             check box (see below).
• Exam Test Name Table – External Lab check box
          • This is a NEW field that was added.
          • Used to designate if the Test is performed at an external lab.
          • This will default into the check box (ExamTest.ExternalLab) on the patient Exam 
             record when the Test is selected either manually, or added via Order Set. 

• ExtTestsOrdered
          • Determination
                    • Coding Logic is looking for the number of EHR Tests with 'Ordered' dates 
                       and the 'External Lab' field checked. 
• ExtTestsReviewed
          • Determination
                    • Coding Logic is looking for the number of EHR Tests with 'Reviewed' dates 
                       equal to the Exam date and the 'External Lab' field checked. 
• ExtTestsInterpreted
          • Determination
                    • Coding Logic is looking for the number of EHR Tests with information in the 
                       'Findings' or 'Interpretation' field, 'Reviewed' dates, 'Independent 
                       Interpretation' checked and the 'External Lab' field checked.

 X (12.4.0.17) 2021 E&M Coding > High Risk Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Determination:
          • It is looking at Surgery records with the following:
                    • The 'Historical' field is NOT checked.
                    • Data documented in the 'High Risk' memo field.
                    • The 'Added' date is equal to the Exam date.
          • It is looking at Treatment records with the following:
                    • The 'Historical' field is NOT checked.
                    • Data documented in the 'High Risk' memo field.
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                    • The 'Performed' date is equal to the Exam date.

 X (12.4.0.17) 2021 E&M Coding > Management Level Determination

• See the Version 12.4 Version Release Notes for full details; this only contains changes.

• Starting 2/22/21 in Version 12.4.0.17: Additional Information:
          • Items below are “Where applicable” based upon your Advantage product:
                    • Determination for Surgery level is based on the following:
                              • The 'Historical' field is NOT checked.
                              • The 'Added' date is equal to the Exam date.
                              • Global Period details for CPT code attached to Surgery/Treatment:
                                        • CPT codes with Global Period between 0 and 10 are 
                                           considered SurgeryMinor.
                                        • CPT codes with Global Period greater than 10 are considered 
                                           SurgeryMajor.

Communication
 (12.4.0.24) InBox > Message > DELETED: RCM Marketing Message

• The RCM Marketing message will no longer pop up upon logging into the software.
• The message will now be sent by PracticeWatch to the Owner's InBox.
• This gives the Owner the option of reading the message at their convenience.

 (12.4.0.24) InBox > Report > ADDED: EDI Utilization Report

• The EDI Utilization report will no longer pop up upon logging into the software.
• The report will now be sent by PracticeWatch to the Owner's InBox daily.
• This gives the Owner the option of viewing the report at their convenience.

 (12.4.0.24) InBox > Report > ADDED: Revenue Cycle Management

• The Revenue Opportunity for clients using AdvantageRCM services can be significant.
• As a reminder, this NEW report will be distributed via PracticeWatch to Owner and 
   Manager InBoxes every 90 days.
• It is a combination of 2 other reports, and is to be used as a client education tool.
• The 'report period' is annualized data for a 365 day year, and is a summary of data.
          • The report period displays at the top of the summary.
• It estimates the costs savings to the practice when Compulink's RCM team handles your 
   claims; including Insurance Payor follow-up, posting payments and patient billing.
• Data includes the following:
          • Insurance payments posted in the report period: $
          • Your savings after calculating the cost for RCM @ 3% of insurance payments 
             received, after minimum receivables: $
          • Annual Billing Cost Savings: $
          • The amount of your collections subject to RCM fees is labeled 'RCM', is highlighted 
             in yellow and includes the following:
                    • All Insurance payments associated with both Service and Material claims 
                       that are submitted through Compulink EDI Solutions, or otherwise 
                       submitted by Compulink on the client's behalf.
                    • All patient payments.
                    • Unapplied Responsible payments, but not unapplied Insurance payments.
• You can see line item detail for this summary by running the following report:
   Report > Financial > Analysis > Advantage RCM Fee Calculation
          • Comparing the reports when run with the same Start/End Posting date range:
                    • The summary at the top of the new report, should match the RCM sections 
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                       of the 'Advantage RCM Fee Calculation' report.
                    • The RCM fee calculation on the new report, should match the last page of 
                       the 'Advantage RCM Fee Calculation' report.

Customization
 X (12.4.0.17) Screen Builder > ALL > Grids Updated to SQL

• In version 12.4.0.16, the option for adding cbsdbgrids and cbsdbfiltergrids was retired.
• Upon update to version 12.4.0.17 and greater, all cbsdbgrid and cbsdbfiltergrid will be 
   updated to sqlgrids. 
• These sqlgrids allow more functionality and flexibility in customization.
• Converting the grids to sqlgrids also provides a performance boost to the software.

Customization > Smart Functions
 (12.4.0.20) Smart Function Editor > ALL > Duplicate Names

• User-Owned Smart Functions can now be saved with the same name as Compulink-
   Owned Smart Functions; allowing the user to Duplicate and use the same name.
• Upon saving the Smart Function, the following message will appear: Visible 
   SmartFunction with SAME Name Already Exists! Do you want to Continue!
          • Click 'No' to go back to the same window and assign a different Name.
          • Click 'Yes' to save the Smart Function with the same name.
• In the screens where the Smart Function is called, if it finds both a Compulink-Owned and
   User-Owned record with the same name, it will run the User-Owned record.
• This allows the user to find a Smart Function connected to a Compulink-Owned screen, go
   and create their own Smart Function, without having to duplicate the screen just to 
   assign a new User-Owned Smart Function name.

 (12.4.0.17) Smart Function Editor > Exam > EDITED: FindLastRecord

• The Smart Function 'FindLastRecord' will now need to reference the name of the SQL grid 
   (GridName:) that contains the data, rather than the table name (Table:).
• The SQL grid that is referenced also needs to contain a column for the fields referenced in
   the FieldNameList; the columns do not have to display, but they do need to be part of the
   SELECT statement.
• The Compulink Product Managers will be updating all grids on the Compulink-Owned 
   Exam screens.
• Previous Example with Table:
          • SF.FindLastRecord('ExamDiag',['DiagUnique'],[Unique]);
• New Example with GridName:
          • SF.FindLastRecord('Diagnosis',['DiagUnique'],[Unique]);
• Example of SQL on grid (Diagnosis):
          • SELECT 
             ExamDiag.DiagUnique,ExamDiag.ExamUnique,ExamDiag.Added,ExamDiag.
             "Order",ExamDiag.Axis,ExamDiag.Code,ExamDiag."Desc",ExamDiag.Resolved,
             ExamDiag.ResolvDesc,zzzspecify, StandardCode1.Short as "Severity", 
             StandardCode.Short as "Change"

Databases
 (12.4.0.19) Databases > Exam.ADT > EDITED: ReviewOfSystems

• The 'Exam.ReviewOfSystems' field was edited, and the Default/Normal value of 'Negative'
   was added.
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Exam > General Changes
 (12.4.0.19) General > Right Click Options > Field Definition > New Option

• The NEW option 'Field Definition' has been added to the Right Click menu.
• This allows the user to have information to create custom reports and documents right at 
   their fingertips.
• Right click in ANY field in the patient Exam and select 'Field Definition'.
• A window opens with the following information:
          • Table – The table name where the field resides
          • Field – The name of the field found in the table 
          • Type – The type of field that it is (example: Character, Logical, Date, etc.)

Exam > Command (Add)
 (12.4.0.20) Command (Add) > Layout List Window > Column Removed

• The 'Tablet' column was removed, as Tablet tabs are identified in the name of the tab.

 (12.4.0.17) Command (Add) > Legacy Health History Information

• When adding a new exam and clicking on the Health History tab, the user will once again
   be presented with the message: Select YES to forward legacy PFSH items into New 
   Health History format!
• This was removed in 12.4.0.16, and then brought back by popular client request.

Exam > Command (E-Rx)
 (12.4.0.20) Command (E-Rx) > Command (Cancel) > Information Added

• The following items were added to the Cancel Confirm window for new certification 
   requirements: 
          • Patient information
          • Pharmacy
          • Drug information

 (12.4.0.18) Command (E-Rx) > Command (Change) > Messages Removed

• When responding to an Rx Change Request , they will no longer need to click 'OK' on a 
   Confirmation message, saving them a click in the process.
• After the response is submitted, they will no longer need to click 'OK' on the Successful 
   Submission message, saving them a click in the process.

 (12.4.0.20) Command (E-Rx) > Command (Change) > Patient Address Added

• The patient's address was added to the 'PATIENT' section.

 (12.4.0.19) Command (E-Rx) > Command (Pharmacy) > See Below

• The following changes were made to the Search area:
          • Name field – A Quick Search option was added to the field. The user may type in a 
             few characters and then hit the enter key, and does not have to click the 'Search' 
             button.
          • Specialty check box – This is a NEW box added to filter the Pharmacy Search for 
             only those that focus on high cost, high touch medication therapy for patients with
             complex disease states. 
• The following changes were made to the Data Display area:
          • Name and Phone columns – The width of the columns were increased. 
          • Zip column – This is a NEW column added to display the Pharmacy Zip Code.
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          • PA column – This is a NEW column added to display if the Pharmacy accepts 
             Electronic Prior Authorization.

 (12.4.0.19) Command (E-Rx) > Command (Refill) > .Window Header Label 
Changed

• The label at the top of the window was changed from 'Refill Request' to 'Renewal Request'
   for new certification requirements.

 (12.4.0.20) Command (E-Rx) > Command (Refill) > Message Removed

• When responding to a Refill Request, after clicking 'YES' to confirm the response, the 2nd 
   message window 'Refill Rx Submitted Successfully!' will no longer display.
• This window was removed to save the user time and clicks.

 (12.4.0.18) Command (E-Rx) > Command (Refill) > Patient Address Added

• The patient's address was added to the 'PATIENT' section.

 X (12.4.0.19) Command (E-Rx) > Command (Refill) > Response Renamed

• The Refill Response 'Denied New to Follow' was changed to 'Replace' for new certification 
   requirements and better usability. 
• With this change, the software will no longer add a new Medication record for “New to 
   Follow”.
• The original Rx will be assigned a 'Stop' date of the current date, and an 'E-Rx Status' of 
   'Refill Request Replaced'; this change is also for new certification requirements.

 (12.4.0.20) Command (E-Rx) > Command (Refill) > Written Labels

• PRESCRIBED and DISPENSED sections
          • The 'Written' labels were removed.

 (12.4.0.20) Command (E-Rx) > Command (Review) > Automatic Start

• If the Screening process produces no results, click the 'X' to close the window, and the 
   software will automatically start the 'Review' process for all Medications in the window; 
   bringing up each individual 'E-Rx Required Drug Review' screen. (Request)

 (12.4.0.19) Command (E-Rx) > Command (Review) > Patient Info Added

• The patient's address and home phone number was added to the 'PATIENT' section for all 
   patients.
• For patients under the age of 18, the patient 'Height' and 'Weight' will display.

 (12.4.0.20) Command (E-Rx) > Command (Review) > Patient Info Added

• The patient's cell phone number was added to the 'PATIENT' section for all patients.

 (12.4.0.20) Command (E-Rx) > Command (Review) > Sig Description

• The length of the Sig Description allowed to be sent is determined by the Pharmacy that 
   is selected.
• Some Pharmacies will only accept a maximum of 140 characters, where others will accept
   a maximum of 1000.
• When the 'Review' command is selected, the software will verify the Pharmacy selected 
   and the number of characters allowed.
• If the maximum length is exceeded, the following message will display (based on #): 
   Sig Description for: (Medication Name) EXCEEDS Maximum Length of 140 characters! 
   You will need to Modify Sig Description using Edit Option to meet Max Length 
   requirements or Select a New Pharmacy which can accommodate a longer Sig 
   Description!
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Exam > Command (E-Rx)
 (12.4.0.20) Command (E-Rx) > Command (Screen) > Automatic Start

• When the 'Screen' command is selected, the screening process will automatically run and 
   then open the Drug Screening window to display the results. (Request) 
• Once the results are displayed, if a change is made to the options at the top (Pregnancy, 
   Geriatric, etc.), the 'Begin' command will need to be selected to restart the Screening 
   process.

Exam > Command (Fees)
 X (12.4.0.18) Command (Fees) > EHR Auto Fee Posting Window > Internal Counts 

& Logical Values

• The box in the bottom left corner is now organized into three sections: Problem 
   Level, Data Level and Management Level.
• Below each section, you will find the items that the coding engine looks at to determine 
   that Level; making it easy for you to get an overview of how the E&M visit code was 
   selected.
• Internal Counts and Logical Values below will vary based upon product:
          • Problem Level
          • Data Level – The items that are looked at to determine this Level, were all moved 
             under this section and indented.
                    • External Tests Reviewed
                    • External Tests Ordered
                    • External Tests Interpreted
                    • Historian Comments
                    • Discussion Notes
                    • Notes Reviewed
          • Management Level – The items that are looked at to determine this Level, were all 
             moved under this section and indented.
                    • Rx
                    • Over the Counter
                    • Self Care
                    • Surgery/Treatment – Changed from 'Surgery'
                    • Risk Factors
                    • Emergency
                    • Unknown Problem
                    • Hospitalization Needed – Changed from 'Hospital'

 X (12.4.0.17) Command (Fees) > EHR Auto Fee Posting Window > Internal Counts 
& Logical Values

• The software, based on what is documented, recommends a coding level using the NEW 
   2021 AMA guidelines. 
• The NEW box in the bottom left corner, displays the 'Internal Counts and Logical Values 
   Determined from Exam Encounter Data which drove the Recommended Coding Level'.
• Internal Counts and Logical Values below will vary based upon product:
          • Problem Level
          • Data Level
          • Management Level
          • External Tests Reviewed
          • External Tests Ordered
          • External Tests Interpreted
          • Historian Comments
          • Discussion Notes
          • Notes Reviewed
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Exam > Command (Fees)
          • Rx
          • Over the Counter
          • Self Care
          • Unknown Problem
          • Hospital
          • Risk Factors
          • Surgery: None, Minor or Major
          • Emergency

 (12.4.0.17) Command (Fees) > EHR Auto Fee Posting Window > New Message

• The following new message will display on the bottom right of the window: By selecting 
   POST you have agreed to the services above. Compulink does NOT assume responsibility 
   of coding level.

Exam > Command (Orders)
 (12.4.0.24) Command (Orders) > Order Details > Referral Removed

• In the 'SMART Patient Orders' window, click on 'Order Details'.
• The option 'Referral' has been removed, as there is no access to the Referral table.

Exam > Command (Print) (General Changes)
 (12.4.0.20) Command (Print) > CCD Document > Encounter Diagnosis Date

• ENCOUNTERS section, Encounter Diagnosis
          • If the 'Diagnosed' field is left blank, the 'Date' will now be left blank. (Request)

 (12.4.0.17) Command (Print) > EHR Reports > EDITED: EXAMOPNOTE

• The report was updated to include any 'Pre-Op Dx' and 'Post-Op Dx' records that are 
   attached to the Surgical Procedures.

Exam > Command (Tab)
 (12.4.0.20) Command (Tab) > Tab List Window >   Columns Removed

• The 'Discontinued' and 'Tablet' columns were removed.
• 'Discontinued' tabs are most likely not being used, and 'Tablet' tabs are identified in the 
   name of the tab.

Exam > Command (Utility)
 (12.4.0.18) Command (Utility) > Coding Logic > EDITED: See Below

• The following entries were edited for the 2021 E&M Coding Engine: 
          • 99202, 99204, 99204 and 99205
          • 99212, 99213, 99214 and 99215
• The following logic was added: .AND.[Psychiatrist Visit]

 (12.4.0.18) Command (Utility) > Coding Logic > Components > ADDED: See 
Below

• The following entry was added for the 2021 E&M Coding Engine: 
          • Psychiatrist Visit ? Upper(Role) <>'THERAPIST'

 (12.4.0.18) Command (Utility) > Coding Logic > Components > EDITED: See 
Below

• The following entries were edited for the 2021 E&M Coding Engine: 
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Exam > Command (Utility)
          • Non-Drug Rx Prescribed ? UPPER(CATEGORY)='GENERAL'
          • Non-Drug Rx Prescribed OTC ? UPPER(CATEGORY)='OTC'
          • SELF-CARE ? UPPER(CATEGORY)='REFERRAL' OR UPPER(CATEGORY)='GENERAL'

 X (12.4.0.18) Command (Utility) > Legacy Field Forward Groups > NEW Table

• This NEW table was created for the Main Exam database, to define multiple Legacy fields 
   that will forward into a single New field when forwarding from a previous date of service.
• The software will only go back 5 years to forward information from one Exam to the next.
• It will only forward Legacy fields that do NOT exist on the same tab as the New field that 
   they are being forwarded to.
• It will forward all field values, even those that are Normal values.
• This table is not sorted. Enter items in the order you would like them displayed in the 
   table. 
• Add – Add a new record to the bottom of the table.
• Complete the fields within the editing window.
          • Owner – 'C' for Compulink-Owned and 'U' for User-Owned.
          • Hide – 'Y' to hide this item from display in drop-down lists.
          • Group Name – Assign a Name to the Group; this could be similar to the label for 
             the single field that the data is going to be forwarded into.
          • Target Field – The name of the single field in the Main Exam that the data will 
             forward into.
          • Source Field List – This list of field names in the Main Exam (separated by a 
             comma) that will forward into the 'Target Field'.
          • Modified – The last date a change was made to this entry.
• Click the check to Save the record.
• Example: 
          • Group Name = ROS
          • Target Field = ReviewOfSystems (This is a new memo field)
          • Source Field List (Legacy fields that will forward into the 'ROS' memo field):
                    • ZZCONSTN = Constitution
                    • ZZCARDION = Cardiovascular
                    • ZZEARSN = ENT
                    • ZZRESPN = Respiratory
                    • ZZGASTRON = Gastrointestinal
                    • ZZGENITON = Genitourinary
                    • ZZMUSCN = Musculoskeletal
                    • ZZINTEGN = Integumentary
                    • ZZNEURON = Neurological
                    • ZZPSYCHN = Psychiatric
                    • ZZENDON = Endocrine
                    • ZZHEMATIN = Hematologic/Lymphatic
                    • ZZALLERGN = Allergic/Immunologic
                    • ZZROSOTHN = Other
                    • ZZEYES = Eyes
• After making changes to the table and exiting, the following message will appear: If 
   Changes Were Made then Please Restart Application for Proper Operation!
          • You must completely close out of the Advantage software and log back in; using 
             the 'Log Off' will not finish the process.

Exam > Layouts (ADDED)
 (12.4.0.17) Layout(s) > ADDED: See Below

• Four new layouts were created, each having 1 of 2 NEW tabs.
• The NEW tabs started as a duplicate of the HiResSessionNote, and were expanded on.
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Exam > Layouts (ADDED)
• The user should be able to select a layout and document most of what is needed for the 
   visit.
• New Layout/Tab:
          • HiRes MH Follow Up / HiResSessNoteMH
          • HiRes MH Intake / HiResSessNoteMH
          • HiRes Psych Follow Up / HiResSessNotePsych
          • HiRes Psych Intake / HiResSessNotePsych

Exam > Layouts (EDITED)
 (12.4.0.17) Layout(s) > EDITED: Psych Simple SOAP

• The NEW tab 'HiResMedicationPsych' was added to the layout to allow Prescribers to 
   prescribe from this simple layout.

Exam > Tabs (ADDED)
 (12.4.0.17) Tab(s) > ADDED: HiResMedicationPsych

• Tab Name: HiResMedicationPsych, Tab Label: Medication

• Created so Prescribers can prescribe from the 'Psych Simple SOAP' layout (tab was added 
   to the layout). 
• There are areas to document/view the following:
          • Current Medications
          • Allergies
          • Alerts
• There are TabAdd options on the left panel for the following:
          • Assessment Tools
          • Addictions
          • Health Hx
          • Review of Systems

 (12.4.0.17) Tab(s) > ADDED: HiResSessNoteMH

• Tab Name: HiResSessNoteMH, Tab Label: Sess Note

• The NEW tab started as a duplicate of the HiResSessionNote, and was expanded on. 
• This tab was added to the NEW layouts 'HiRes MH Follow Up' and 'HiRes MH Intake' to 
   allow the user to select a layout and document most of what is needed for the visit.
• There are areas to document/view the following:
          • Therapy/Treatment
          • History
                    • Click the ellipsis hover menu and select 'History Multiple Entry' to bring up 
                       the NEW 'Evaluation Tools' tab to choose from a list of History GridEdits.
                    • Click on a History label to bring up the GridEdit, make your selections and 
                       save the window.
                    • All records will display in the 'History' grid on the 'HiResSessNoteMH' tab.
          • Symptoms/Behaviors
          • Diagnosis/Plan
          • Psychological Assessments
                    • Click the ellipsis hover menu and select 'Add Assessment Tool' to bring up 
                       the 'Psychological and Substance Assessments' tab to choose from the list 
                       of Assessment Tools.
          • Goals
          • Objectives/Goal Steps
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Exam > Tabs (ADDED)
          • Staff Who Entered Data/signOff's/Other Professionals

 (12.4.0.17) Tab(s) > ADDED: HiResSessNotePsych

• Tab Name: HiResSessNotePsych, Tab Label: Sess Note

• The NEW tab started as a duplicate of the HiResSessionNote, and was expanded on. 
• This tab was added to the NEW layouts 'HiRes Psych Follow Up' and 'HiRes Psych Intake' 
   to allow the user to select a layout and document most of what is needed for the visit.
• There are areas to document/view the following:
          • Therapy/Treatment
          • History
                    • Click the ellipsis hover menu and select 'History Multiple Entry' to bring up 
                       the NEW 'Evaluation Tools' tab to choose from a list of History GridEdits.
                    • Click on a History label to bring up the GridEdit, make your selections and 
                       save the window.
                    • All records will display in the 'History' grid on the 'HiResSessNotePsych' tab.
          • Diagnosis/Plan
          • Medication Monitoring
          • Medications
          • Psychological Assessments
                    • Click the ellipsis hover menu and select 'Add Assessment Tool' to bring up 
                       the 'Psychological and Substance Assessments' tab to choose from the list 
                       of Assessment Tools.
          • Staff Who Entered Data/signOff's/Other Professionals

Exam > Tabs (EDITED)
 (12.4.0.24) Tab(s) > EDITED: All PopUp Tabs Accessing Materials

• Enhancement done to all PopUp tabs that access the ExamMaterial database.

• Name field
          • Click the drop-down to open the 'Select Item' window showing Inventory items.
          • The 'Name' column has been expanded to display the full Inventory Name, without
             having to drag the dividing line. (Request)

 X (12.4.0.20) Tab(s) > EDITED: All Tabs With Diagnosis/Plan or Dx/Plan

• The 'Forward' functionality was updated. 
          • When forwarding a Diagnosis from a previous Exam, if the 'Severity' and 'Change' 
             fields already contain a value, those values will forward, and the prompt to select 
             a value will not pop up. (Request) 
          • The user still has the option of editing the Diagnosis and making changes.

Exam > Look-up Tables
 X (12.4.0.24) Look-up Tables > Medication > Pharmacy > NCPDP ID Mandatory

• NCPDP ID is the unique, national identification number assigned by the National Council 
   for Prescription Drug Programs (NCPDP) to every licensed Pharmacy in the United States 
   and its territories.
• All Pharmacies being used for electronic prescribing, must have an 'NCPDP ID'.
• Surescripts will NOT accept any Pharmacies that do not contain this information.
• When selected from the 'Pharmacy Search' window, the information will default.
• If adding a Pharmacy to the table manually, you must make sure to enter the 'NCPDP ID' 
   if this Pharmacy is going to be used for electronic prescribing.
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Exam > Look-up Tables
• If the Pharmacy is unable to provide their NCPDP ID, contact the NCPDP for 
 assistance. https://www.ncpdp.org/Contact-Us.aspx

 (12.4.0.24) Look-up Tables > Medication > Unit Measure > EDITED: See Below

• Surescripts will sunset many Unit Measure items with the update to the new certification 
  software.
• The following is a list of only the items that ARE REMAINING on the list:

• Applicator
• Blister
• Caplet 
• Capsule
• Each
• Film
• Gram
• Gum
• Implant
• Insert
• Kit
• Lancet
• Lozenge
• Milliliter
• Packet
• Pad
• Patch
• Pen Needle
• Ring
• Sponge
• Stick
• Strip
• Suppository
• Swab
• Tablet
• Troche
• Unspecified
• Wafer

 (12.4.0.19) Look-up Tables > Diagnosis > Name > Problem Severity

• The 'Problem Severity' field is now available for editing in the table.
• Users may now go into the table and establish default values. (Request)

Function

Function > Portal Communication
 (12.4.0.20) Portal Communication > Post Patient Payments

• The posting of patient portal payments has been added to the function.
• The payments are downloaded into the practice's Payment table in real-time throughout 
   the day, and then PracticeWatch is set up to automatically post them to the patient 
   Ledgers at specific intervals.
• If you would like to manually post them, and not wait for PracticeWatch, you may now 
   run the Portal Communication function.

Ledger

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com               36



Ledger > General Changes
 (12.4.0.18) General > Global Period Message > Modifier 1 Added

• If a Modifier was added to the charge that was posted with a Global Period, that 1st 
   Modifier will now display in the Global Period reminder message that pops up when 
   entering the patient Ledger. (Request)

Ledger > Charge Window
 (12.4.0.20) Charge Window > NDC Button > Lock Units From Exam

• When posting charges from the Exam (either directly from the Exam, or via the EHR Post 
   command), if the user clicks the NDC button, the Units field is grayed out and locked 
   from being edited. (Request)

Ledger > Command (Credit)
 (12.4.0.24) Credit > Auto Resp. Materials > Include Tax Line

• The Credit option 'Auto Resp. Materials' will now recognize the Sales Tax line as eligible 
   for automatically posting money to during the payment process.

Ledger > Command (Options)
 (12.4.0.19) Command (Options) > Collection > Command (Add) > Plan Selection

• Click the drop-down at the 'Plan' field to open the 'Select Collection Plan' window.
• This window will now open in the middle of the Collection window. (Request)

Look-up Tables

Look-up Tables > EHR
 X (12.4.0.17) EHR > Test > Name > Field(s) ADDED

• External Lab – Used to designate if the Test is usually performed at an external lab; 
   default is blank/False. 
          • This will default into the field on the patient Exam record when the Test is selected 
             either manually, or added via Order Set.

Look-up Tables > General
 (12.4.0.19) General > Departments > Identification > Command (Print) > NEW 

Command & Report

• The NEW 'Print' command was added to the table. When clicked, it will merge the data in 
   the user-defined 'Display Order' into a NEW Crystal Report. (Request)

 (12.4.0.19) General > Staff > Groups > Command (Detail) > Add > Terminated 
IDs
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Look-up Tables > General

• Login IDs that contain a Termination date will no longer display as an option when clicking
   'Detail > Add'. (Request)

 X (12.4.0.17) General > Labs > List > Field(s) UPDATED

• External – Upon update, all Compulink-Owned labs will be flagged 'Y' for External.

Look-up Tables > Marketing
 (12.4.0.20) Marketing > Event > Category > NEW Table Added

• The 'Marketing Event Category' table is used to define different types of Marketing Events
   that a practice may participate in, or host.
• These Categories will be connected to the Events in the 'Marketing Event Definition' table.
• This table sorts alphabetically by the 'Value' field.
• Add – Add a new record to the table.
• Complete the fields within the editing window:
          • Display Order – Used to control the position of items in drop-down lists. Enter a 
             number between 1 and 999998. Default is blank.
          • Owner – Compulink (C) or User Owned (U).
          • Hide – A table entry marked Hide Y does not display in drop-down lists in the 
             patient's record.
          • Value – Category (Example: Education or Sale)
          • Modified – Date this table entry was last modified; system assigned and not 
             editable.

 (12.4.0.20) Marketing > Event > Definition > NEW Table Added

• The 'Marketing Event Definition' table is used to keep track of Marketing Events that a 
   practice may participate in, or host; these can be Providers and Non-Providers.
• This table sorts alphabetically by the 'Name' field.
• Add – Add a new record to the table.
• Complete the fields within the editing window:
          • Start – Start date of the Event.
          • End – End date of the Event.
          • Name – Name of the Event.
          • Category – Type of Event, selected from the drop-down of choices established in 
             the 'Marketing Event Category' table.

Patient

Patient > Command (Insurance)
 (12.4.0.17) Command (Insurance) > New Icons

• New Icons were added for the 'Eligibility' and 'Episode' commands.

Patient > Command (Jump)
 (12.4.0.18) Command (Jump) > Group >   Command Moved

• The 'Group' command was moved off of the 'Jump' menu and back to the main menu.

Patient > Command (Print)
 (12.4.0.18) Command (Print) > Audit Report >   Edited: See below

• The 'Audit Events' total was moved to the bottom of the report, or the last page.
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Patient > Command (Print)
• This total also now includes the following 'Extended Audit' items:
          • Acct Responsible
          • Insured
          • Patient Action Items/ToDos
          • Patient Contacts
          • Patient Lock-Out
          • Recalls
          • Referrals

Patient > Command (Search)
 (12.4.0.19) Command (Search) >   Web Registration PopUp

• If the patient that is being searched for matches a pending name in the Registration table
   for importing/updating, when the user selects the patient from the Search window, the 
   software will go to that record and automatically bring up the 'Select Patient Web 
   Registration' window with the matching name.
• To import the information, double click on the patient name and follow the steps for 
   importing Demographic information. 
• If this is NOT the patient you searched for, simply close the window with the 'X'.
• IMPORTANT NOTE: The workstation must be setup with a Patient Tracking Stop that has a
   Category of 'Check-In' for the Web Registration automatic PopUp to function.

 X (12.4.0.19) Command (Search) > Command (Advanced) >   Message For 
Restrictions

• If the staff logged in has a Provider, Staff Group or Location Group assigned in the Login 
   IDs table, the following message will display when clicking the 'Advanced' command: 
   Advanced SQL Search Unavailable for Users that have Restrictions on which Patients can 
   be Accessed due to Assigned Provider or Staff/Groups! Solution scheduled for availability 
   in version 12.5 next Quarter!

Patient > Command (Utility)
 (12.4.0.20) Command (Utility) > Appt History >   Display Change

• Under the 'Time' column, the seconds have been removed to clean up the screen.

 (12.4.0.18) Command (Utility) > Appt History > Command (Utility) >   NEW 
Command

• The NEW 'Utility' command was added with the option of 'Remove Pending Appointments'.
• It is a maintenance tool that may be needed on rare occasions.
• This gives the user the ability to delete unfinished Appointment records that occupy a 
   time slot, but were not completed; time slots may seem missing.
• This could be due to a software crash, power loss, connectivity problem, etc. 
• Note: After running the Utility, the records are cleared in the database, but the user will 
   not see any message displayed on the screen.

Printer & Output Tools
 (12.4.0.21) Workstation Configuration > Tablet Mode Change

• If the workstation is set to 'Tablet Mode'=Y, the screens will now have the 'X' in the top 
   right corner to close out, just like the Non-Tablet Mode.

 (12.4.0.19) Turn Tablet Mode On/Off > Option Removed

• The 'Turn Tablet Mode On/Off' option was removed from the menu, as it is part of the 

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com               39



Printer & Output Tools
   'Workstation Configuration' on the same menu.

 (12.4.0.18) Grid Hover Menu > New Message

• After selecting 'Grid Hover Menu', the following message displays: Select OK to Confirm 
   Turning ON/OFF Grid Hover Menu option!
• After selecting OK, the following NEW message will display: Hover Menu change will Begin
   when Tabs are initially Loaded!
• This means that you will not see the change immediately on the tab that you are on, as it 
   was already loaded.
• As you click on the other tabs, they will load, and you will see the change.
• To see the change to the tab where the Hover Menu was toggled ON/OFF, you will need to
   exit and re-enter the Exam.

Reports

Reports > Appointment
 (12.4.0.18) Appointment > Analysis > EDITED: Utilization

• Parameter/Option changes:
          • View If Zero Duration? - Option to include/not include Appointments with a 
             duration of zero minutes. Default is 'True' to view/include those Appointments. 
             Change to 'False' to exclude them, and only see Appointments with a duration 
             equal to 1 or more minutes. (Request)

Reports > Electronic Health Record
 (12.4.0.24) Electronic Health Record > ADDED: 2021 PI Patient List

• This NEW report locates patients who are part of the patient population (denominator) for
   one or more of the 2021 Promoting Interoperability measures. (Request)
• You must first create a data set for in the Dashboard.

 (12.4.0.24) Electronic Health Record > ADDED: 2021 PI Simple List

• This NEW report shows the Promoting Interoperability performance measures tracked in 
   EHR. (Request)
• The PI reports mirror what happened in the Dashboard.
• To report on an individual clinician's PI outcomes, you must have created a data set for 
   that individual ID in the Dashboard.

 (12.4.0.17) Electronic Health Record > MEANINGFUL USE > EDITED: CQM Totals 
Only (2014-2021)

• Report Title (Request) 
          • The report title was updated from 'CQM Totals Only (2014-2019)
• Report Detail
          • The report was updated to include 2020-2021 information.

Reports > Financial
 (12.4.0.24) Financial > Acct Management > ADDED: QPP (PQR) Compliance 2021

• This NEW report is similar to the 2020 version.
• Use it to determine your Physician Quality Reporting Percentage for each Measure. 
   (Request)
• Measures included on this report can be found on the Quality tab in your EHR.
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Reports > Financial
• The following Detail Measures are included: 128, 130, 134, 181, 226 and 317.
• Parameter/Option changes:
          • Only Unbilled Charges? – Option to see only unbilled claims. (Request)
                    • The report is looking at the 'Last Billed' date for the primary Payor on the 
                       charge.
                    • Default is 'False' to include both billed and unbilled claims (with and
                       without a date in the field).
                    • If set to 'True', the report will only include unbilled claims (without a date in
                       the field).
                    • Running the report for unbilled claims only, gives the staff the opportunity 
                       to review claim coding for these measures before you send them to 
                       Medicare for processing.
• Report changes:
          • Unbilled claims are highlighted.
• The Compulink Support team suggests this report be run OFTEN, to ensure that your 
   office is using COMPLETE CODING for the best score possible!

 (12.4.0.21) Financial > Acct Management > EDITED: Collection Accounts

• Parameter/Option changes:
          • COLLECTION PLAN
                    • Reminder that this field may NOT be left blank, as Collection setup requires 
                       a Plan to be entered.
          • AGENCY
                    • The Parameter/Option was updated, and may now run with the following 
                       choices:
                              • * – Report will include items with and without a collection Agency in 
                                 the Collection setup.
                              • BLANK – If left blank, the report will include ONLY items without an 
                                 Agency in the Collection setup.
                              • Wildcard – Wildcards allowed. Example Agency: ABest Collections
                                        • Selected with Option '*'
                                        • Selected with Option 'A*'
                                        • Selected with Option'?Best Collections'

 (12.4.0.21) Financial > Analysis > EDITED: Payments by Payor

• Parameter/Option changes:
          • Separate Self-Pay charges? (Request) 
                    • This is a NEW Parameter/Option added.
                    • Option to separate the Responsible payments applied to both Self-Pay 
                       charges with no Insurance attached and charges with an Insurance 
                       attached.
                    • Default is 'False' to not separate out the Self-Pay charges, and display the 
                       data as usual on the report.
                    • If set to 'True', the following will display on the report:
                              • Resp. (Self Pay Charges) – Responsible payments applied to a 
                                 charge WITHOUT Insurance attached.
                              • Resp. (Ins. Attached) – Responsible payments applied to a charge 
                                 WITH Insurance attached.

 (12.4.0.19) Financial > Analysis > EDITED: Charge Collection Analysis

• Parameter/Option changes:
          • Location Group – Run the report for an individual Service Location, All Locations or 
             a Location Group of your design. 
                    • Default is '*' for All Location entries.
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                    • If 'All Locations' is selected from the drop-down, verify that all Locations 
                       are connected to this option in the Location > Groups table.
                    • This parameter can include wildcards, and will ignore duplicates.
                              • Example 1:
                                        • Location Group 'Westside Clinics' = SCI, SCX, LCI and LCX 
                                        • Location Group 'Westside Offices' = LCI, WRO and LCX
                                        • Location Group 'Eastside Clinics' = JPL, EGT
                                        • Wildcard selection for 'Location Group': Westside*
                                        • Default selection for 'LOC (Service Location)': *
                                        • Report result = SCI, SCX, LCI, LCX and WRO (All Locations in 
                                           the Location Groups that start with 'Westside', minus any 
                                           duplicates).
                              • Example 2:
                                        • Location Group 'Westside Clinics' = SCI, SCX, LCI and LCX 
                                        • Location Group 'Westside Offices' = LCI, WRO and LCX
                                        • Location Group 'Eastside Clinics' = JPL, EGT
                                        • Wildcard selection for 'Location Group': Westside*
                                        • Selection for 'LOC (Service Location)': LC*
                                        • Report result = LCI and LCX (Only Locations in the Location 
                                           Groups that start with 'LC', minus any duplicates).
          • Staff Group – ID – Run the report for an individual Service Provider ID, All 
             Providers or a Staff Group of your design. 
                    • Default is '*' for All Provider entries.
                    • If 'All Providers' is selected from the drop-down, verify that all Providers 
                       are connected to this option in the Staff > Groups table.
          • Staff Group – Aux ID – Run the report for an individual Service Auxiliary ID, All 
             Auxiliary IDs or a Staff Group Auxiliary IDs of your design. 
                    • The report is only looking at the primary Aux ID, not Aux ID 2.
                    • Default is '*' for All Auxiliary ID entries.
                    • If 'All Providers' is selected from the drop-down, verify that all Providers 
                       are connected to this option in the Staff > Groups table.

 (12.4.0.17) Financial > Acct Management > ADDED: A/R Responsible Snapshot 
(LIP)

• This report gives the user the option to run an A-R Snapshot with back-dateable 
   Responsible Only balances (non-zero). (Request) 
• It is suitable for the Line Item Accounting environment only.
• Parameters/Options:
          • Location Group – Location code on the Patient Demographics. Default is * for All.
          • A/R Date – Show account balances as of the A-R Date. Default is the current date.
                    • If left with the current date, then the A/R BAL and RESP BAL should match 
                       the Current A/R Bal and Resp. Bal in the report.
                    • If this date is backdated, then the A/R BAL and RESP BAL are a 'snapshot' 
                       of what the account balances were as of the date that was entered.
          • Sort (A-Acct# N-Name B-Balance) – Sort order for the accounts within each 
             Location group; highest to lowest. Default is A to sort by account number.
          • HIDE Expanded Detail? – True produces a single line summary for each account 
             (the default). False expands to a second line of information important to collection 
             staff. 
          • All Status? (False=Collectn Only) – True includes all accounts with a balance over 
             the minimum (the default). False filters for accounts on Collection only.
          • Maximum Balance (Responsible) – Default is 999999. If 'Maximum A-R Balance' is 
             set to $0, the report will only show accounts with a Credit Balance.
          • Minimum Balance (Responsible) – Default is negative (999,999) dollars. You can 
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             set that amount higher or lower. Report shows accounts with A-R BAL of that 
             amount or higher, up to the Maximum value set.
• Report Detail:
          • The report is organized by Location.
          • Location headers contain the following:
                    • LOCATION – Location Code (Patient Demographic)
                    • A-R DATE – The A/R date chosen in the report options
          • Location Detail information contains the following:
                    • NAME – The Account Responsible Name associated with the account
                    • ACCT# – The Ledger Account Number
                    • COL – A 'Y' indicates the account is On Collection and an 'N' indicates the 
                       account is not
                    • HOME PHONE – The Account Responsible's home phone number
                    • A/R BAL – The Account balance as of the A/R date chosen in the report 
                       options
                    • RESP BAL – The Responsible balance as of the A/R date chosen in the 
                       report options
          • Location footers contain the following A/R Date Totals for the Location:
                    • # of Accounts
                    • A/R BAL – The Account balance for all accounts
                    • RESP BAL – The Responsible balance for all accounts
                    • Current A/R Bal – The Current Account balance as of the report 
                       print/generation date for all accounts (Request) 
                    • Resp. Bal – The Responsible balance as of the report print/generation date 
                       for all accounts (Request) 
          • GRAND Totals for Report contain the following:
                    • # of Accounts
                    • A/R BAL – The Account balance for all Locations
                    • RESP BAL – The Responsible balance for all Locations
                    • Current A/R Bal – The Current Account balance as of the report 
                       print/generation date for all Locations (Request) 
                    • Resp. Bal – The Responsible balance as the report print/generation date for 
                       all Locations (Request) 
• Report Expanded Detail:
          • Running the report with option 'HIDE Expanded Detail?' set to 'False' will display 
             additional Account Responsible information.
                    • CUR RESP BAL – Current Responsible balance as of the A/R date chosen
                    • CUR INS BAL – Current Insurance balance as off the A/R date chosen
                    • LAST PAID – Last Responsible Payment date
                    • LAST BILLED – Last Statement date
                    • CELL PH – The Account Responsible's cell phone number
                    • WORK PH – The Account Responsible's work phone number
                    • EXT – The Account Responsible's work phone number extension

 (12.4.0.17) Financial > Acct Management > EDITED: Sales Tax History

• Parameter/Option changes:
          • Exclude Loc/Cat Rate = 0? – This NEW option allows the user to exclude charges 
             that are marked Taxable=Y, if the 'Rate' field in the 'Sales Tax by Loc/Category' 
             table is '0.00' for that Loc/Category. (Request)
                    • Default is 'True' to exclude; change to 'False' to include those charges.
                    • Example: Table designates Rate of 0% for Loc=001 and Category=SG. If 
                       run with 'True', ALL table charges for Loc=001 with Category=SG will be 
                       excluded from the report.

 (12.4.0.17) Financial > Acct Management > REMOVED: See Below
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• The following reports were removed, as they are no longer needed: (Request) 
          • E Prescribe Compliance
          • E Prescribe Compliance 2010
          • E Prescribe Compliance 2011

Reports > Inventory
 (12.4.0.19) Inventory > Need to Order > Menu Update

• The Need to Order report was moved to a sub-menu in order to standardize the menus 
   across all products.
• Highlight 'Need to Order' to access the 'Misc. Inventory Need to Order' report.

 (12.4.0.19) Inventory > Outstanding Orders > Menu Update

• The Outstanding Orders report was moved to a sub-menu in order to standardize the 
   menus across all products.
• Highlight 'Outstanding Orders' to access the 'Misc. Outstanding Orders' report.

Reports > Referral
 (12.4.0.22) Referral > General > EDITED: Referrals Out

• Report changes:
          • Report Header
                    • The 'Location(s)' label was updated to 'Location (Patient)' to identify that 
                       the report is looking at the Location code on the Demographic screen.
                    • The 'ID' label was updated to 'ID (Patient Provider)' to identify that the 
                       report is looking at the Provider ID on the Demographic screen.
          • Chart
                    • The chart label 'Referral' was moved to the left, to avoid possibly interfering
                       with the Referral Sources that merge into the report.

Reports > System Admin.
 (12.4.0.20) System Admin. > EDITED: PracticeWatch Task History

• Parameter/Option changes:
          • Begin Date (Task Start Date)
                    • This was renamed from 'Start Date (Task Start)'.
          • Start Hour (0 to 24)
                    • This is a NEW Parameter/Option.
                    • Include PracticeWatch Tasks run from this Hour (in military time) of the 
                       START DATE. 
                    • Default is 0.
          • End Date (Task Start Date)
                    • This was renamed from 'End Date'.
          • End Hour (0-24)
                    • This is a NEW Parameter/Option.
                    • Include PracticeWatch Tasks run through this Hour (in military time) of the 
                       END DATE. 
                    • Default is 24.
          • Include Hidden Tasks?
                    • This is a NEW Parameter/Option.
                    • Option to include Tasks that are marked Hidden=True or not.
                    • Default is 'True' to show all Tasks. PracticeWatch sets some one-time Tasks 

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com               44



Reports > System Admin.
                       to Hide=True when finished running.
                    • If set to 'False', no Tasks marked as Hidden will show.
          • Show Task Detail?
                    • This is a NEW Parameter/Option.
                    • Option to show Task Definition detail or not.
                    • Default is 'False' to not show detail.
                    • If set to 'True', some Task Detail will show, such as the parameters that 
                       were used to run a report.

• Report changes:
          • Report Summary
                    • Data Source and Report Definition is expanded at the top to include 
                       information about the new Parameters/Options.
                    • Will include Tasks marked as Hide=Y if Parameter/Option set to 'True'.
                    • Every other row is highlighted for clarity in reading.
          • Report Detail
                    • Detail is NEW, and will be different, based upon the Task.
                              • Text Message Tasks – These will include the message sent. (Request)
                    • Information includes the following:
                              • Task Owner – Either 'C' for Compulink or 'U' for User
                              • Hide? – A 'Y' for Yes or 'N' for No to indicate if the Task is currently 
                                 marked as Hidden
                              • Definition – Task detail (a report task will list the Parameters/Options
                                 used to run the report)
                              • Discontinued? – A 'Y' for Yes or 'N' for No to indicate if the Task is 
                                currently marked as Discontinued

Utility

Utility > Miscellaneous Utilities
 (12.4.0.18) Miscellaneous Utilities > Convert Word Doc/Docx files to Open Office 

ODT > Option Removed

• The option 'Convert Word doc/Docx files to Open Office ODT' has been removed from the 
   menu, as it is no longer needed.
• OpenOffice (ODT files) have been the standard for many years, and we are now moving 
   to LibreOffice, that does not require conversion.

Utility > PracticeWatch Setup
 (12.4.0.19) PracticeWatch Setup > Task (Text) > Patients with appointments 

tomorrow

• The SQL for running the Text Message 'Patients with appointments tomorrow' has been 
   updated to now merge the Appointment Location and Provider, instead of the 
   Demographic information. (Request)

Utility > System Administrator
 (12.4.0.22) System Administrator > Login > Profiles > Right EDITED

• EHR Data
          • The NEW option 'Add/Edit/Subtable Delete' was added.
          • This gives the user the option to delete from an Exam Subtable record (grid), while
             still preventing them from deleting the entire Exam. (Request)
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 (12.4.0.21) System Administrator > Login > Profiles > Right EDITED

• System Administrator
          • If set to 'None', the user will no longer have access to the following areas:
                    • Utility > System Administrator > Fax Setup
                    • Utility > System Administrator > PracticeWatch Service Install

 (12.4.0.18) System Administrator > System Setup > EDITED: Bill ID Override Aux 
field #

• PATH: Utility > System Administrator > System Setup > Miscellaneous Tab
• Miscellaneous section
          • The 'Bill ID Override Aux field #' field was edited for NEW INSTALLS, and the '1' 
             was removed.
          • EXISTING clients should review the field to make sure that it is set up correctly for 
             their office billing choice.
• Bill ID Override Aux Field # (for on-demand claims printed from the patient ledger)
          • Used to populate the rendering provider on claims with either the first or second 
             Ledger Auxiliary ID.
          • This works in conjunction with the Bill Ins. by ID/Loc in the Account Ledger section
             below.
          • If Bill Ins. ID/Loc is set to unchecked, the demographic ID is used for the 
             rendering provider on the claim.
          • If Bill Ins. ID/Loc is set to Y then the software looks at the value in the Bill ID 
             Override Aux Field # field.
                    • If empty or zero, the Ledger ID is used for the rendering provider on the 
                       claim.
                    • If '1', then the first Ledger Aux ID is used for the rendering provider.
                    • If '2', then the second Ledger Aux ID is used for the rendering provider.

Worklists

Worklists > Global
 (12.4.0.19) Global > EDITED: Failed Communications

• The history displayed will now only go back 30 days.
• The 'Delete' command was added to the Worklist window. (Request) 
          • This gives the user the option to delete old Failed Communications that they are 
             not interested in following up on.
          • Highlight the item and click 'Delete', then select 'Yes' on the following message: 
             Press YES to Confirm Removal of item from Document History Worklist.

Worklists > Patient
 (12.4.0.18) Patient > EDITED: See Below

• The format of the names of the Worklists below were updated for consistency:
          • Patients Accessed – All ID's – By Date
          • Patients Accessed – Login ID – By Date
          • Patients Accessed – Today All ID's
          • Patients Accessed – Today Login ID
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